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«Interactive Dashboard» report 
Dashboard is a type of a report with the following components: “Pivot”, “Grid”, “Chart”, “Scatter Chart”, “Pies”, “Gauges”, “Cards”, “Treemap”, “Filter Elements”, “Images”, “Text Box”, “Group”. 
Upon starting a program, a dashboard-type report appears in reports tree. 
[image: ]
Note: this one must be created by administrator.


When the report type «Interactive Dashboard» is opened, the following window appears:
[image: ]

The list of all the reports will be shown on the left:
· Admin’s – reports created by administrator
· My – owner’s reports
· Shared – reports shared with other users.

Dashboard elements themselves are shown on the right.
As we can see, there is no My Dashboards list. Let us create an «Interactive Dashboard».

	
[bookmark: _Toc522112836][bookmark: _Toc15045668]How to create an «Interactive Dashboard»
There are several ways to create an «Interactive Dashboard»:
[image: ]
Way 1. In a “Dashboard” menu choose “Add”.
Way 2. Click “Add new Dashboard” button in a toolbar.
A window appears, where you should write a name for the «Interactive Dashboard»:
[image: ]


As a result, a dashboard designer window will appear:
[image: ]


[bookmark: _Toc522112837][bookmark: _Toc15045669][bookmark: _Toc514852342][bookmark: _Toc486344360][bookmark: _Toc506544536]Basic dashboard navigation 
We will take a previously-created dashboard as an example of navigation:
[image: ]
A toolbar with dashboard elements is located in the upper part of the window:
· Pivot
· Grid
· Chart
· Scatter Chart
· Pies
· Gauges
· Cards
· Treemap
· Range Filter
· Filter Elements
· Images
· Text Box
· Group
The following functionality is available for dashboard elements:
· Title
· Currency
· Edit Colors
· Parameters


In the left part of the window there is a data source (OLAP DB) with respective hierarchies, dimensions. One dashboard can have several data sources:
[image: ] 
Note: In order for a dashboard to have several data sources you should contact an administrator.
[bookmark: _Toc486344702]
[bookmark: _Toc522112838][bookmark: _Toc15045670]Dashboard elements
[bookmark: _Hlk14168149]Dashboard designer window consists of following elements:
· Pivot
· Grid
· Chart
· Scatter Chart
· Pies
· Gauges
· Cards
· Treemap
· Ghoropleth Map
· Geo Point Maps
· Range Filter
· Filter Elements
· Images
· Text Box
· Group
[bookmark: _Toc514852344][bookmark: _Toc486344362][bookmark: _Toc506544538][bookmark: _Toc522112839][bookmark: _Toc486344704][bookmark: _Hlk14168225][bookmark: _Toc15045671]
Create, delete, convert to, duplicate and other possibilities
[bookmark: _Toc522112840][bookmark: _Toc15045672]Create
[bookmark: _Hlk14168247]In order to create a new dashboard element, you need to click a respective icon in dashboard designer window:
[image: ]
[bookmark: _Toc486344705][bookmark: _Toc522112841][bookmark: _Toc15045673]Delete
[bookmark: _Hlk14169852]In order to delete a dashboard element, you need to click an icon in a toolbar:
[bookmark: _Hlk14169894][image: ]
[bookmark: _Hlk14169902]In order to quickly delete all the filled fields of one of a dashboard element (grid, chart, etc.) you need to click an icon:
[image: ]
[bookmark: _Toc486344706][bookmark: _Toc522112842][bookmark: _Toc15045674]Convert To
[bookmark: _Hlk14169926]It is possible to modify one dashboard element into another by choosing a respective item in the toolbar:
[image: ]
[bookmark: _Toc486344707][bookmark: _Toc522112843][bookmark: _Hlk14169996][bookmark: _Toc15045675]
Duplicate
[bookmark: _Hlk14169961]In order to duplicate an existing dashboard element, you need to click an icon in a toolbar:

[image: ]
[bookmark: _Toc486344708][bookmark: _Toc522112844][bookmark: _Toc15045676]Transpose
[bookmark: _Hlk14170012]For such dashboard element as pivot, chart, scatter chart, diagram there is a possibility to transpose lines and columns for a grid, parameters and sets of diagrams, axes “X” and “Y” of a chart:
[image: ]
[bookmark: _Toc486344709][bookmark: _Toc522112845][bookmark: _Toc15045677]Pivot
[bookmark: _Hlk14170053]Pivot is a multidimensional array of data. 
[bookmark: _Hlk14170098]Let us take a “Pivot” that shows volume of sales and profit by product category in each country as an example. For this we choose “Pivot” in the toolbar, in the value field we will have  “Reseller Sales Amount” and “Reseller Gross Profit” measures, on the rows of the “Country” and “Category” hierarchy. The pivot will look the following:
[image: ]
[bookmark: _Toc514852351][bookmark: _Toc486344369][bookmark: _Toc506544545][bookmark: _Toc522112846][bookmark: _Hlk14170263][bookmark: _Toc15045678]
Expand/minimize 
[bookmark: _Hlk14170274][bookmark: _Toc486344711]By clicking [image: ] and [image: ] buttons, you can expand/minimize data to needed extent.
[bookmark: _Toc15045679][bookmark: _Toc522112847]Layout type
[bookmark: _Hlk14170305]The Pivot layout can be:
· [bookmark: _Hlk14170377]Compact
[bookmark: _Hlk14170384][image: ]
· [bookmark: _Hlk14170394]Tabular
[bookmark: _Hlk14170404][image: ]
[bookmark: _Hlk14170442]
Use the “Layout” button in the “Design” ribbon tab to change the Pivot layout:
[image: ]
[bookmark: _Toc15045680]Totals
[bookmark: _Hlk14170496]You can control the visibility of totals and grand totals for the entire Pivot dashboard item:
[image: ]
[bookmark: _Toc15045681]Initial state
[bookmark: _Hlk14170579]“Initial State” of a pivot may be the following:
[image: ]
· [bookmark: _Hlk14170676]Expand Column Groups
· Expand Row Groups
[bookmark: _Hlk14170695]
By ticking this functionality box, we will always see an expanded level:
[image: ]
[bookmark: _Toc15045682]Grand Totals
[bookmark: _Hlk14170889]In the pivot table, you can enable or disable grand totals:
[image: ]
[bookmark: _Toc15045683]Totals
[bookmark: _Hlk14170957]For the pivot of the tabular type (s. 1.5.2), you can enable and disable totals for the highest level:
[image: ]
For instance, the image below displays the Pivot dashboard item with the disabled row totals:
[bookmark: _Hlk14171034][bookmark: _Hlk14171039][image: ] [image: ]
[bookmark: _Hlk14171071]Moreover, you can control the visibility of totals for individual dimensions/measures by using the data item's context menu (“Show Totals” and “Show Grand Totals” options):
[bookmark: _Hlk14171087][image: ]
[bookmark: _Hlk14171547][bookmark: _Toc15045684]
Totals Position
[bookmark: _Hlk14171599]If necessary, you can change the Pivot dashboard item’s totals/grand totals position:
[bookmark: _Hlk14171608][bookmark: _Hlk14171615][image: ]           [image: ]
[bookmark: _Hlk14171623][bookmark: _Hlk14171627][image: ]    [image: ]
[bookmark: _Toc15045685]Values Position
[bookmark: _Hlk14171674]The Pivot dashboard item allows you to control the position of headers used to arrange summary values corresponding to different measures:
[image: ]
[image: ] [image: ]
[bookmark: _Toc486344712][bookmark: _Toc522112848][bookmark: _Hlk14171787][bookmark: _Toc15045686]
Filter
[bookmark: _Hlk14171801]In the tab Data it is possible to create a quick filter for the whole pivot. It could be done in two ways:
Way 1. Click “Change filter” button in “Data” tab in dashboard design window.
[image: ]
[bookmark: _Hlk14171855]Way 2. Open context menu (click the right mouse button) at any place of a pivot.
[bookmark: _Hlk14171866][image: ]
[bookmark: _Hlk14171892]
Only those hierarchies, which are present in the report, may be a filter for a Pivot:
[bookmark: _Hlk14171904][image: ]
[bookmark: _Hlk14171914]Let us display, for instance, values “Reseller Sales Amount” and “Reseller Gross Profit” for product categories “Bikes” and “Clothing”:
[bookmark: _Hlk14171918][image: ]
[bookmark: _Hlk14172054]
Pivot will look the following:
[bookmark: _Hlk14172062][image: ]
[bookmark: _Toc486344713][bookmark: _Toc522112849][bookmark: _Toc15045687]Format
[bookmark: _Hlk14172080]In order to change the format of a calculating value, you need to open context menu:
[bookmark: _Hlk14172087][image: ]
[bookmark: _Hlk14172101]
A numeric-format form will open:
[bookmark: _Hlk14172107][image: ]
[bookmark: _Hlk14172125]The form contains following fields:
· Format type – format type may be:
[image: ]
· Unit – Date and currency format type may have the following presentation:
[image: ]
· Precision – number of symbols after comma;
· Currency – currency will use toolbar parameters by default (interface language), or you could choose specific currency type from a dropdown list;
· Culture – reference culture for a region should be specified;
· Include group separator – turn a space on/off.
[bookmark: _Toc486344714][bookmark: _Toc522112850][bookmark: _Hlk14172142][bookmark: _Toc15045688]
Formatting
[bookmark: _Hlk14172167]Upon opening value context menu, it is possible to create a formatting rule (highlighting):
[bookmark: _Hlk14172173][image: ]
[bookmark: _Hlk14172209]In abstract 1.18 a process of creation of formatting rules is described in more details.
[bookmark: _Toc486344715][bookmark: _Toc522112851][bookmark: _Toc15045689]Title
[bookmark: _Hlk14172256]Before saving a created pivot let us rename its title.
This may be done in two ways:
Way 1. In “Design” tab press “Edit names” icon.
[image: ]
[bookmark: _Hlk14172326]
Way 2. Open context menu in a pivot (click the right mouse button) and choose “Edit names” from the list.
[bookmark: _Hlk14172333][image: ]
[bookmark: _Hlk14172352]In an appeared form enter the following data:
[bookmark: _Hlk14172380][image: ]
[bookmark: _Hlk14172399]	Now a pivot title looks the following:
[bookmark: _Hlk14172405][image: ]
[bookmark: _Hlk14172457]If needed, title may not be displayed:
[image: ]
[bookmark: _Hlk14172511]Before closing a pivot should be saved by clicking a “Save” icon in the toolbar:
[image: ]
[bookmark: _Hlk14172560]Or an application will offer to save a pivot itself:
[bookmark: _Hlk14172565][image: ]
[bookmark: _Hlk14172575]
A new dashboard element — a pivot Reseller will be the result:
[image: ]
[bookmark: _Hlk14173023]For next dashboard element editing it is needed to click an “Edit” icon in the toolbar:
[image: ]
[bookmark: _Toc486344716][bookmark: _Toc522112852][bookmark: _Hlk14173087][bookmark: _Toc15045690]
Export
[bookmark: _Hlk14173099]If needed you can export a pivot into PDF, Excel or a picture format by clicking the right mouse button in a pivot:
[bookmark: _Hlk14173112][image: ]
· [bookmark: _Hlk14173138]
Export To PDF
The following options are available when exporting the Pivot dashboard item to a PDF:
[image: ]
· Page Layout – page orientation;
· Size – page size;
· Show Title – to display or not to display page title;
· Title – name of page title;
· Print Headers on Every Page – to print or not to print a title on every page;
· Scale Mode – zoom mode;
· Scale Factor – specifies the scale factor (in fractions of 1) by which a dashboard is scaled;
· Auto Fit Page Count – specifies the number of horizontal/vertical pages spanning the total width/height of a dashboard;
· Include Filters / Parameters – allows you to include master filter values / parameter values to the exported document;
· Position – specifies the position of the master filter and parameter values in the exported document.

· 
Export To Excel
While exporting into Excel the following options are available:
[image: ]
· Excel Format – xlsx, xls, csv formats;
· Separator – specifies the string used to separate values in the exported CSV document;
· Include Filters / Parameters – allows you to include master filter values / parameter values to the exported document;
· Position – specifies the position of the master filter and parameter values in the exported document.

· Export to Image.
            While exporting into a picture format the following options are available:
 [image: ]
· Image Format – PNG, JPEG, GIF formats;
· Show Title – specifies the image format in which the dashboard item is exported;
· Title – name of a pivot title;
· Resolution(dpi) – specifies the resolution (in dpi) used to export a dashboard;
· Include Filters / Parameters – allows you to include master filter values / parameter values to the exported document.
[bookmark: _Toc486344717][bookmark: _Toc522112853][bookmark: _Toc15045691]Grid
[bookmark: _Hlk14173203]Let us add a new element called Grid to an already-existing dashboard. 
For this we first click an “Edit” icon on a dashboard toolbar, and then in a dashboard design window click a “Grid” button:
[image: ]
[bookmark: _Hlk14173417]Let us look at the grid, which will display the results of sales by product categories. In the column move a “Category dimension and a “Reseller Sales Amount” measure:
[bookmark: _Hlk14173422][image: ]
[bookmark: _Toc486344718][bookmark: _Toc522112854][bookmark: _Toc15045692]Column type
[bookmark: _Hlk14173527]Columns in a grid may be of the following type:
[bookmark: _Hlk14173533][image: ]
[bookmark: _Hlk14173541][image: ]
· [bookmark: _Hlk14173556]Dimension – a column shows DB dimension;
· Measure – a column shows measure value;
· Delta – a column, which shows a delta of two measures, where one is an actual and the other – a target;
· Sparkline – a chart, which shown a measure value in a given interval (date and time);
· Hyperlink – a hyperlink column allows you to display hyperlinks in the Grid dashboard item;
· Auto – a column type is defined automatically.
[bookmark: _Toc486344719][bookmark: _Toc522112855][bookmark: _Toc15045693]Delta column
[bookmark: _Hlk14173583]Let us create a column of a “Delta” type. Choose the type and click an «ОК» button:
[bookmark: _Hlk14173589][image: ]
[bookmark: _Hlk14173623]In a column field two new fields – “Actual” and “Target” appear. Let’s choose a “Reseller Internet Quantity” measure for real values (actual), and a “Reseller Order Quantity” measure will be a target. We will get a new column, which will show a delta value and its indicator:
[bookmark: _Hlk14173652][image: ]
[bookmark: _Hlk14173661]A delta value type may be the following:
[bookmark: _Hlk14173690][image: ]
· [bookmark: _Hlk14173707]Actual value – an actual measure value;
· Absolute variation – difference between an actual and a target;
· Percent variation – percent of difference between an actual and a target;
· Percent of target – percent of an actual and a target.

An indicator may have the following value:
[bookmark: _Hlk14173719][image: ]
· [bookmark: _Hlk14173732]Greater is good – «good» a target is achieved (an actual is bigger than a target);
· Less is good – «bad» a goal is not achieved (an actual is less than a target);
· Warning if greater – a target is bigger than an actual;
· Warning if less – a target is less than an actual;
· No indication – indication is not displayed.
For the delta, you can set the threshold value, which will indicate the excess of the actual above the target.
[bookmark: _Hlk14275793]
The threshold can be of the following type:
[bookmark: _Hlk14173749][image: ]
[bookmark: _Hlk14173772]Let's get back to our grid and see if the target is achieved as a percentage. For this, let’s fill out the form as follows:
[bookmark: _Hlk14173792][image: ]
[bookmark: _Hlk14173810]
As a result, we will see a delta column in which all the values exceeding the target are highlighted with a green indicator, and the red values are those that have not reached a target:
[bookmark: _Hlk14173817] [image: ]
[bookmark: _Hlk14173846]Obviously, the target was achieved only for “Accessories” category.	
The delta value can be displayed not only as text, but also as a diagram:
[bookmark: _Hlk14173864][image: ]
[bookmark: _Hlk14173882][image: ]
[bookmark: _Toc486344720][bookmark: _Toc522112856][bookmark: _Hlk14173963][bookmark: _Toc15045694]
Sparkline Column
[bookmark: _Hlk14173973]Let's create a column of a “Sparkline” type. For this, let’s consider how the quantity of orders for product categories changed depending on the month of the year. For this, we will insert the “Reseller Order Count” measure in the columns and select the “Sparkline” column type:
[bookmark: _Hlk14173983][image: ]
[bookmark: _Hlk14173997]The following settings will be available in the opened form:
· Show start/end values – species whether or not to display sparkline start/end values within a grid cell;
· Sparkline view type:
· Line
· Area 
· Bar
· Win/Loss – a column-type graph (of the same size) with a Win (maximum value) mark and a Loss (minimum value) mark.
· Highlight min/max points 
· Highlight start/end points.
[bookmark: _Hlk14174051]
Fill out the form in the following way:
[bookmark: _Hlk14174080][image: ]
[bookmark: _Hlk14174093]Then in the “Sparkline” field, drag the “Month of Year” dimension. As a result, we get the following report:
[bookmark: _Hlk14174097][image: ]
[bookmark: _Hlk14174151]
The following data is displayed in the sparkline column:
[bookmark: _Hlk14174162][image: ]
[bookmark: _Toc15045695]Hyperlink column
[bookmark: _Hlk14174187]A hyperlink column allows you to display hyperlinks in the Grid dashboard item.
You can provide hyperlinks as a separate data column or they can be automatically created at run-time from any column using the specified URI pattern.
[bookmark: _Hlk14174206]Data Field Containing Uri Values
[bookmark: _Hlk14174218]For example, take the data source of type excel-table, which contains the following fields:
[image: ]
[bookmark: _Hlk14174231]
Now let's create a table and fill it with the following data:
[bookmark: _Hlk14174238][image: ]
[bookmark: _Hlk14174257]The Grid displays column values as clickable hyperlinks allowing you to navigate to the Wiki's pages:
[bookmark: _Hlk14174261][image: ]
[bookmark: _Hlk14174273]You can bind the display value and URI value to different data fields. Click the “New Column” data item placeholder:
[bookmark: _Hlk14174277][image: ]
[bookmark: _Hlk14174292]
and change its type to “Hyperlink”:
[bookmark: _Hlk14174297][image: ]
[bookmark: _Hlk14174311]Drag and drop the “OfficialName” field to the display value data item placeholder to display official country names. Drag and drop the “Link” field to the Uri data item placeholder to specify URIs.
The Grid displays official country names with links obtained from the Link data source field:
[bookmark: _Hlk14174318][image: ]
[bookmark: _Hlk14175083]
URI
[bookmark: _Hlk14175097]In this case, a specified URI pattern is used to generate links.
Create the following grid:
[bookmark: _Hlk14175106][image: ]
[bookmark: _Hlk14175127]Click the “Column Type” indicator button next to the “Name” data item and change its type to “Hyperlink”. Specify the URI Pattern option as follows:  https://en.wikipedia.org/wiki/{0}
[bookmark: _Hlk14175156][image: ]
[bookmark: _Hlk14175171]The {0} placeholder is replaced with the “Name” data item value. The links are generated for country names and displayed in the grid as illustrated in the following picture:
[bookmark: _Hlk14175177][image: ]
[bookmark: _Toc486344721][bookmark: _Toc522112857][bookmark: _Toc15045696]Drill Down
[bookmark: _Hlk14175209]Let's see what product subcategories in the “Accessories” category were of positive dynamics. For this, in the “Data” tab on the toolbar, click the “Drill Down” icon
[image: ]
[bookmark: _Hlk14175326]and in the grid itself, in the “Columns” field under the “Category” hierarchy, drag the “Subcategory” hierarchy:
[bookmark: _Hlk14175331][image: ]
[bookmark: _Hlk14175414]Now by clicking the “Accessories” product category, we will see all the product subcategories that it includes:
[image: ]

In order to get back to the initial grid view click a grid icon:
[image: ]
[bookmark: _Toc522112858][bookmark: _Toc15045697]Additional grid properties
[bookmark: _Hlk14175455]In a “Design” tab of a Grid dashboard element the following toolbar is available:
[image: ]
· [bookmark: _Hlk14175604]Horizontal Lines – show horizontal grid lines;
· Vertical Lines – show vertical grid lines;
· Banded Rows – banded rows are not supported when cell merging is enabled;
[bookmark: _Hlk14175614][image: ]
· [bookmark: _Hlk14175625]Merge Cells – merge adjacent cells with identical data (“Drill Down” has to be off);
[bookmark: _Hlk14175633][image: ]
· [bookmark: _Hlk14175654]Column – show column headers;
· Word Wrap;
· AutoFit to Contents;
· AutoFit to Grid;
· Manual – adjust the width of columns manually.

[bookmark: _Hlk14175671]
By clicking a grid title, the following functionality will be available:
[bookmark: _Hlk14175683][image: ]
· [bookmark: _Hlk14175698]Fit to Content – fit the column width to its content;
· Fit Width – specify the column width and fix it;
· Column Width – specify the fixed column width;
· Add Format Rule – possibility to choose one of the formatting ways form a dropdown list (the process is described in more details in abstract 1.18);
· Edit Rules – possibility to change the existing highlighting rules;
· Clear Rules – deletion of all the highlighting rules;
· [bookmark: _Hlk14175737]Add Total – possibility to display:
[bookmark: _Hlk14175742][image: ]
· [bookmark: _Hlk14175754]Clear Totals– delete all summaries.
Let's display the minimum and maximum value of the “Reseller Sales Amount” measure in our grid:
[bookmark: _Hlk14175768][image: ]
[bookmark: _Toc486344723][bookmark: _Toc522112859][bookmark: _Toc15045698]Export
[bookmark: _Hlk14175826]A grid can be exported into PDF, Excel or a picture format. Way are described in abstract 1.5.13.
[bookmark: _Toc486344724][bookmark: _Toc522112860][bookmark: _Toc15045699]
Chart
[bookmark: _Hlk14176621]To create a chart, you need to click a “Chart” icon in the dashboard designer window on the toolbar:
[bookmark: _Hlk14176627][image: ]
[bookmark: _Hlk14176638][bookmark: _Hlk14270837]As a result, a new dashboard element appears:
[bookmark: _Hlk14176642][image: ]
[bookmark: _Hlk14176660]The left item contains the following chart parameters:
· Values – measure, data is displayed on the Y-axis;
· Argument – dimension, data is displayed on the Х-axis;
· Series – dimension, data that is used to create series.
In the field on the right there will be a chart itself.
[bookmark: _Hlk14176759]
Let us create a chart, which will show the sales volume of product categories by year. Having filled in the fields as in the picture below, you will get the following chart:
[image: ]
Let us change its type:
[image: ]
[bookmark: _Hlk14176814]
A window of the following view will open:
[bookmark: _Hlk14176817][image: ]
[bookmark: _Hlk14176827]The first tab “Series Type” allows redefining a chart type.  Among all the suggested options, let us choose “Full-Stacker Bar”:
[bookmark: _Hlk14176831][image: ]
[bookmark: _Hlk14176868]
A “Common Options” tab offers following possibilities:
[bookmark: _Hlk14176873][image: ]
· [bookmark: _Hlk14176887]Plot on secondary axis – data is displayed secondary axis
· Ignore empty points – not to display zero values in a chart;
· Show point markers - for a chart of an “Area” type point markers are displayed.

We will not change anything here.

In a “Point Label Options” tab, the following possibilities are available:
[bookmark: _Hlk14176901][image: ]
· [bookmark: _Hlk14176924]
Content:
· Select All
· Argument
· Series Name 
· Percent
· Overlapping mode:
· Hide overlapping labels – hide overlapping labels;
· None – display all the labels;
· Reposition  overlapping labels – hide overlapping labels regime is off (all the labels without overlapping will be shown).
· Orientation:
· Default – labels are located horizontally;
· Rotate to the Right – labels rotation for 90 degrees clockwise;
· Rotate to the Left - labels rotation for 90 degrees counterclockwise.
· Bar options:
· Show for zero values – to display or not to display zero values;
· Position – labels position either outside or inside (for Histograms and Bubbles).
Fill out the following tab as shown below:
[bookmark: _Hlk14176934][image: ]
[bookmark: _Hlk14176976]
As a result, the report will have the following view:
[image: ]
Let us add one more data panel:
[image: ]
[bookmark: _Hlk14177008]
To the existing chart, we add one more panel that displays the number of orders for all the same product categories by year. For this, drag the “Reseller Order Count” measure to the value bar, select the “Spline” type of the chart and set the following parameters on the remaining tabs:

[image: ]
[image: ]
As a result, we will get the following chart:
[bookmark: _Hlk14177051][image: ]
[bookmark: _Toc486344725][bookmark: _Toc522112861][bookmark: _Toc15045700][bookmark: _Hlk14177064]X/Y – Axis settings 
[bookmark: _Hlk14177077]The chart in the dashboard has two axes – “X” and “Y”. The “X”-axis is the axis of the arguments, and the “Y”-axis is the numerical axis of the measure value. The following options for chart are in the “Design” tab:
[image: ]
· Rotate  - rotate the diagram at 90°
· “Х”-Axis Settings
· “Y”-Axis Settings
Let us have a look at the settings for each axis.
For “Х”-axis, the following parameters are available:
[image: ]
· Reverse – display values in descending order;
· Enable zooming 
· Show X-axis
· Show title
· Default text – dimension name
· Custom text – text, entered by a user
· Limit visible points – a number of visible point on an axis.

[bookmark: _Hlk14177112]
For “Y”-axis, the following parameters are available:
[image: ]
· Always show zero level
· Reverse – rotate an axis at 180°
· Show grid lines – to display or not to display grid lines
· Show axis – show/hide an axis 
· Show title – to display or not to display a title;
· Default text – dimension name
· Custom text – text, entered by a user
· Logarithmic scale – to display or not to display a logarithmic scale.
[bookmark: _Toc486344726][bookmark: _Toc522112862][bookmark: _Toc15045701]Legend
[bookmark: _Hlk14177141]To change the location of the legend, go to the “Design tab”: [image: ]
[bookmark: _Hlk14177196]The following functionality will be available on the toolbar:
· Show Legend – to display or not to display a legend;
· Legend location:
[image: ]
[bookmark: _Hlk14177210][image: ]
[bookmark: _Toc486344727][bookmark: _Toc522112863][bookmark: _Hlk14177254][bookmark: _Toc15045702]
Series Type
[bookmark: _Hlk14177264]You can change the type of the row on the toolbar in a “Design” tab.
[image: ]
[bookmark: _Hlk14177294]The following chart types are available in the drop-down list:
[bookmark: _Hlk14177298][image: ]
[bookmark: _Toc486344728][bookmark: _Toc522112864][bookmark: _Toc15045703]Edit Colors
[bookmark: _Hlk14177320]You can change the color of the chart elements in two ways:
Way 1. Click an “Edit Colors” icon in the “Design” tab toolbar: [image: ]
[bookmark: _Hlk14177357]Way 2. Click the same icon in the toolbar of the dashboard designer window:
[image: ]
[bookmark: _Hlk14181693]
In the window that appeared, select the required element and set the color for it:
	[image: ]
[bookmark: _Toc486344729][bookmark: _Toc522112865][bookmark: _Toc15045704]Drill Down
[bookmark: _Hlk14181722]Such a function as Drill Down is possible for charts. It is described in abstract 1.6.5 in more details.
[bookmark: _Toc486344730][bookmark: _Toc522112866][bookmark: _Toc15045705]Export
[bookmark: _Hlk14181756]Charts can be printed and exported into PDF, Excel or an image. Ways to do this are described in abstract 1.5.13
[bookmark: _Toc486344731][bookmark: _Toc522112867][bookmark: _Toc15045706]
Scatter Chart
[bookmark: _Hlk14181814]In order to create a scatter chart click a “Scatter Chart” icon in “Dashboard Designer” window toolbar:
[image: ]
[bookmark: _Hlk14181827]	An empty scatter chart will appear:
[image: ]
[bookmark: _Hlk14181928]A scatter chart contains the following fields:
· “Х”-Axis - contains the data item against which the X-coordinates of data points are calculated;
· “Y”-Axis - contains the data item against which the Y-coordinates of data points are calculated;
· Weight - contains the data item whose values are used to calculate the weight of data points;
· Argument - contains data items providing scatter chart arguments that are used to create data points.
Let us build a scatter that will display the values of the “Sales Amount” measure and “Gross Profit Margin” measure for product categories, and the size of the circle will correspond to the value of the “Gross Profit” measure.
[bookmark: _Hlk14182092]To do this, drag the “Sales Amount” measure to the “X”-axis, “Gross Profit Margin” measure to the “Y”-axis , “Gross Profit” to the “Weight” field, and drop the “Category” hierarchy into the argument:
[bookmark: _Hlk14182079][image: ]
[bookmark: _Hlk14182103]By default, a scatter chart does not contain the elements coloring. In order to color the elements, you need to select “Hue” from the drop-down list by right-clicking the “Category” hierarchy in the context menu:
[bookmark: _Hlk14182110][image: ]
[bookmark: _Hlk14182139]
As a result, a scatter chart will have the following view:
[image: ]
Let us find out which subcategories of products of the “Bikes” category gave such a high profit. To do this, select the “Subcategory” hierarchy in the argument field, and enable the “Drill Down” in the “Data” tab:
[image: ]
[bookmark: _Hlk14182303]By clicking the “Bikes” product category, we will see the number of product subcategories that it includes, and the corresponding measures values for them:

[bookmark: _Hlk14182308][image: ]
[bookmark: _Hlk14182344]Let us turn “Hue” on for subcategories as well:
[image: ]  
[bookmark: _Hlk14182392]After that, a scatter chart will get back to its initial view. However, after clicking “Bikes” product category again, we will get the following view of a scatter chart:
[image: ]
[bookmark: _Hlk14182535]To return to the previous detail level (drill up), use the Drill Up button (the [image: ] icon).
[bookmark: _Toc486344732][bookmark: _Toc522112868][bookmark: _Toc15045707]X/Y – Axis settings 
[bookmark: _Hlk14182563]In a Design tab, there are the following scatter chart parameters:
[bookmark: _Hlk14182567][image: ]
· [bookmark: _Hlk14182580]Rotate  - rotate at 90°
· “Х”-Axis Settings
· “Y”-Axis Settings
[bookmark: _Hlk14182593][bookmark: _Toc486344733]Note: axis properties are described in more details in abstract 1.7.1
[bookmark: _Toc522112869][bookmark: _Toc15045708]
Point Labels
In order to display points, values in a scatter chart, you need to click the following icon in “Design” tab in a toolbar:
[image: ]
As a result, a form with the following parameters will appear:
[image: ]
· Show point labels – to display or not to display labels;
· Content – labels values
· Argument – point labels show argument values;
· Weight – point labels show the weight summary value;
· Values – point labels show summary values from “X” and “Y”-axes;
· Argument and weight - point labels show the argument value and the corresponding weight summary value;
· Argument and values - point labels show argument values and corresponding summary values.
· Overlapping mode
· Hide overlapping labels – if two or more labels overlap, some of them are automatically hidden to avoid overlapping;
· None - the overlapping resolving algorithm is disabled;
· Reposition overlapping labels - the default algorithm to re-position point labels in a random way, and avoid overlapping labels.
· Orientation:
· Default – A point label is displayed in its default orientation;
· Rotate to the Right – A point label is rotated 90 degrees clockwise;
· Rotate to the Left - A point label is rotated 90 degrees counter clockwise.
· 
Position
· Outside – labels are located inside a point;
· Insite – labels are located outside a point.
For a scatter chart, you can also change legend's location and redefine coloring for toolbar elements. This process is described in more details in abstracts 1.7.2 and 1.7.4.
[bookmark: _Toc486344735][bookmark: _Toc522112871][bookmark: _Toc15045709]Drill Down
For a Scatter Chart such functionality as “Drill Down” is also available. Its working principle is described in abstract 1.6.5.
[bookmark: _Toc486344736][bookmark: _Toc522112872][bookmark: _Toc15045710]Export
When it is necessary, you can print or export a Scatter Chart into PDF, Excel or an image. 
· Export To PDF
While exporting, the following options are available:
[image: ]
· Page Layout – specifies the page orientation used to export a Scatter Chart dashboard item;
· Size – specifies the standard paper size;
· Show Title – specifies whether or not to apply the dashboard item caption to the exported document title;
· Title – specifies the title of the exported document;
· Size Mode - specifies the export size mode for the Scatter Chart dashboard item;
· Include Filters / Parameters – allows you to include master filter values / parameter values to the exported document;
· Position – specifies the position of the master filter and parameter values in the exported document.

· Export to Excel
See abstract 1.5.13
· Export to Image
See abstract 1.5.13
[bookmark: _Toc486344737][bookmark: _Toc522112873][bookmark: _Toc15045711]Pies
In order to create Pies, click the following icon in a dashboard designer window:
[image: ]
Let us create pies that will display the gross profit margin by product categories. For this, let us move the “Gross Profit Margin” measure into a value field, and “Category” into an argument:
[image: ]

Now let us have a look how “Gross Profit Margin” measure value has changed through the years. For this, let us move “Calendar Year” into rows:
[image: ]
If necessary, you can quickly swap the value of an argument and a row by using the following icon on the toolbar:
[image: ]
[bookmark: _Toc486344738][bookmark: _Toc522112874][bookmark: _Toc15045712]Layout
In a “Design” tab, you can define the way to display pies elements:
[image: ]
· Auto Arrange – by default, the “Auto Arrange” option is enabled, which automatically resizes pies to fit within the dashboard item;
· 
Arrange in Columns – place the elements in the given number of columns:
[image: ]
· 
Arrange in Rows – place the elements in the given number of rows:
[image: ]
[bookmark: _Toc486344739][bookmark: _Toc522112875][bookmark: _Toc15045713]
Labels
Pies display “data labels” that contain descriptions for pie segments, and provide “tooltips” with additional information:
[image: Опис : Опис : https://documentation.devexpress.com/HelpResource.ashx?help=Dashboard&document=img19947.jpg]
[image: ]
In “Data Labels” and “Tooltips” drop-down lists, you can choose one of the ways to display data values:
[image: ]
Let us display the value of “Gross Profit Margin” in the data signatures of our pies, while in the tooltips - the share value, and display the signatures to the pies itself:
[image: ] [image: ]
Pies will look the following:
[image: ]
[bookmark: _Toc15045714][bookmark: _Toc486344740][bookmark: _Toc522112876]Data Labels Position
Data Labels Position may be as follows:
[image: ]
[bookmark: _Toc15045715]Style
Pie has two ways to display:
[image: ]
[bookmark: _Toc486344741][bookmark: _Toc522112877][bookmark: _Toc15045716]Edit Colors
Default colors can be edited if needed. This process is described in more details in abstract 1.7.4.
[bookmark: _Toc485912299][bookmark: _Toc486344742][bookmark: _Toc522112878][bookmark: _Toc15045717]Drill Down
Such a function as Drill Down is available for pies. Its working principle is described in abstract 8.6.5.
[bookmark: _Toc486344743][bookmark: _Toc522112879][bookmark: _Toc15045718]Export
If needed, pies can be exported into PDF, Excel or an image. It is described in more details in abstract 1.5.13
[bookmark: _Toc486344744][bookmark: _Toc522112880][bookmark: _Toc15045719]  Gauges
In order to create a dashboard element called “Gauges” you need to click the following icon in a designer window toolbox of a dashboard:
[image: ]
Gauges is a kind of an indicator, which displays the following values: target, actual, delta value.
Target is a gauges arrow, “Actual” is a gauges sign on the scales, “Delta” is an indicator sign on a gauges.
Let us have a look at gauges that have “Reseller Sales Amount” measure as a target, and “Internet Sales Amount” as a actual, and analyze them in terms of product categories. For this, fill in the fields in the following way:
 [image: ]
As a result, we will get some gauges:
[bookmark: _Hlk14186122][image: ]
[bookmark: _Toc486344745][bookmark: _Toc522112881][bookmark: _Toc15045720]
Delta
[bookmark: _Hlk14186271]By default, a gauge shown the difference between an actual and a target. This difference is called delta:
[bookmark: _Hlk14186275][image: ]
[bookmark: _Hlk14186291]In order to change delta settings you need to click the following icon:
[image: ]
A form with the following indicator parameters will appear:
[image: ]
[bookmark: _Hlk14186320]
Value type:
· Actual Value – value of an actual measure;
· Absolute Variation  – difference between an actual and a target;
· Percentage Variation – percent of difference between an actual and a target;
· Percentage of Target – percent of an actual and a target.
Result indication:
· Greater is Good – The 'good' indication is displayed if the actual value exceeds the target value; if the target value exceeds the actual value, the 'bad' indication is displayed;
· Less is Good – The 'bad' indication is displayed if the actual value exceeds the target value; if the target value exceeds the actual value, the 'good' indication is displayed;
· Warning if Greater – A warning is displayed if the actual value exceeds the target value; otherwise, no indication is displayed;
· Warning if Less – A warning is displayed if the target value exceeds the actual value; otherwise, no indication is displayed;
· No Indication – Indication is not displayed. 
For the delta, you can set the threshold value, which will indicate the excess of the actual above the target. The threshold type can be percent or absolute.
Let us display the percentage of difference between an actual and a target for our gauges. We are interested in those values for which the percentage of difference is greater than zero. For this, fill out the form as follows:
[bookmark: _Hlk14186462][image: ]
[bookmark: _Hlk14186505]As a result, we will get gauges of the following view:
[bookmark: _Hlk14186603][image: ]
[bookmark: _Toc486344746][bookmark: _Toc522112882][bookmark: _Toc15045721]Gauge Scale
[bookmark: _Hlk14186710]By default, the Gauge dashboard item automatically determines the range of the gauge scales based on the values they display.
You can override this behavior and specify maximum and minimum values on the scale:
[bookmark: _Hlk14186718][image: ]
[bookmark: _Toc486344747][bookmark: _Toc522112883][bookmark: _Toc15045722]Layout
[bookmark: _Hlk14186738]Different layout options are available for gauges. Principle and working method are described in abstract 1.9.1. 
[bookmark: _Toc486344748][bookmark: _Toc522112884][bookmark: _Toc15045723]Style
[bookmark: _Hlk14186757]The Gauge dashboard item allows you to select the gauge type:
[image: ]
[bookmark: _Toc486344749][bookmark: _Toc522112885][bookmark: _Toc15045724]Drill Down
[bookmark: _Hlk14186827]Such a function ad “Drill Down” is available for indicators. Working principle of this functionality is described in abstract 1.6.5.
[bookmark: _Toc486344750][bookmark: _Toc522112886][bookmark: _Toc15045725]Export
[bookmark: _Hlk14186848]You can print indicators as well as export them into PDF, Excel or an image. The ways are described in abstract 1.5.13.
[bookmark: _Toc486344751][bookmark: _Toc522112887][bookmark: _Toc15045726]
Cards
[bookmark: _Hlk14249138]To create a “Cards” dashboard element, click the toolbar icon in the dashboard designer window:
[image: ]
[bookmark: _Hlk14249624]A “Cards” dashboard element is a series of cards, each of which displays the difference between two values (measures).
Let's show the difference between the two measures “Reseller Sales Amount” and “Reseller Total Product Cost” for subcategories of products. For this, fill in the fields as follows:
[image: ]
As a result, we received several cards that display:
[image: ]
[bookmark: _Toc486344752][bookmark: _Toc522112888][bookmark: _Hlk14249920][bookmark: _Toc15045727]
Delta
[bookmark: _Hlk14249948]In order to set or change the delta value, you must click (the [image: Опис : https://documentation.devexpress.com/HelpResource.ashx?help=Dashboard&document=img20167.jpg] icon):
[image: ]
In the opened form “Card Settings” go to the “Delta Options” tab:
[image: ]
Then, specify the following settings:
· Result indication:
· Greater is good – the 'good' indication is displayed if the actual value exceeds the target value; if the target value exceeds the actual value, the 'bad' indication displays
[image: ]
· 
Less is good – the 'bad' indication displays if the actual value exceeds the target value; if the target value exceeds the actual value, the 'good' indication displays
[image: ]
· Warning if greater – a warning is displays only if the actual value exceeds the target value
[image: ]
· Warning if less – a warning is displays only if the target value exceeds the actual value; otherwise, no indication is displayed
[image: ]
· No Indication – indication is not displayed.
[image: ]
For the delta, you can set a threshold value, which will indicate an excess of an actual above a target.
The threshold type can be percent or absolute.
[bookmark: _Toc486344753][bookmark: _Toc522112889][bookmark: _Toc15045728]Sparkline
[bookmark: _Hlk14249979]Sparklines can be used to visualize the variation of actual or target values (for instance, over time).
Let us analyze the change in actual value in terms of months of the year. For this, move the “Month of Year” hierarchy into the “Sparkline” field:
[bookmark: _Hlk14249998][image: ]
[bookmark: _Hlk14250051]
Sparkline itself has the following parameters:
[image: ]
· Sparkline view type - defines the sparkline’s view type. Sparkline data points can be represented as area, line, bars, or win and loss squares.
· Highlight min/max points - specifies whether to highlight the minimum/maximum points of a sparkline;
· Highlight start/end points –
 specifies whether to highlight the start/end points of a sparkline.
[bookmark: _Toc15045729][bookmark: _Toc486344754][bookmark: _Toc522112890]Card Layouts
To change a card's layout, click the “Options” button (the [image: ] icon) displayed next to the data item container in the Cards section:
[image: ]

In the form that opens, the following layouts are available on the “Layout Options” tab:
[image: ]
· Stretched – the Stretched layout template arranges card elements so that they occupy an entire card area
[image: ]
· 
Centered – the Centered layout template is used to center card elements so that they occupy a specified width/height
[image: ]
· Compact – the Compact layout template is used to arrange card elements so that they occupy the minimum area
[image: ]
· Lightweight – the Lightweight layout template displays the minimum set of elements within a card
[image: ]

For all layout types, you can change the visibility of its elements, or you can specify the display value type for data-bound elements:
[image: ]
On the “Layout Options” tab, select the required layout type in the “Select template” list and specify its settings:
· Min width - specifies the minimum width of the card content;
· Max width - specifies the maximum width of the card content. Use the “Auto” option to determine the maximum width automatically;
You can show/hide the following values and visual elements within the card:
· Actual Value – a summary value for a measure placed in the Actual placeholder;
· Title – displays values of the last (bottommost) dimension placed in the Series section;
· Subtitle – displays combined values of all dimensions except the last (bottommost) dimension;
· Percent Variation – a percent difference between the actual and target value;
· Absolute Variation – an absolute difference between the actual and target value;
· Delta Indicator – indicates whether the actual value is less or greater than the target value
· Sparkline – visualizes the variation of actual or target values.

[bookmark: _Toc15045730]
Format Options
[bookmark: _Hlk14251797]The Card dashboard item formats the actual and target values displayed within cards using format settings specified for data items. Click the options buttons (the [image: ] icon) displayed next to the data item container in the Cards section to change format settings for other values:
[image: ]
In the invoked “Card Settings” dialog, go to the “Format Options” tab and use the “Select value type” option to specify which values’ format settings should change:
[image: ]
[bookmark: _Toc15045731]Cards Arrangement
[bookmark: _Hlk14251840]The following display methods are available for the cards in the “Design” tab:
[image: ]
[bookmark: _Hlk14251908]The principle of functionality is similar to that of Pies – abstract 1.9.1
[bookmark: _Toc486344755][bookmark: _Toc522112891][bookmark: _Toc15045732]Drill Down
[bookmark: _Hlk14252377]Such a function as Drill Down is available for Cards. The principle of this functional is described in abstract 1.6.5.
[bookmark: _Toc486344756][bookmark: _Toc522112892][bookmark: _Toc15045733]Export
[bookmark: _Hlk14252397]Cards may be exported into PDF, Excel or an image. Ways to do this are described in abstract 1.5.13
[bookmark: _Toc486344757][bookmark: _Toc522112893][bookmark: _Toc15045734] Treemap
[bookmark: _Hlk14252439]To create a Treemap, click the corresponding icon on the toolbar:
[image: ]
[bookmark: _Hlk14252506]Let us display the volume of sales by product categories. Having filled in the fields as in the picture below, we get a treemap of the following view:
[bookmark: _Hlk14252521][image: ]
[bookmark: _Hlk14252610]
Now add a “Subcategory” hierarchy into an “Argument” fields:
[bookmark: _Hlk14252627][image: ]
[bookmark: _Hlk14252639]Let us group the subcategories of one group of products:
[bookmark: _Hlk14252643][image: ]
[bookmark: _Hlk14252653]
As a result, a Treemap will look as follows:
[bookmark: _Hlk14252657][image: ]
[bookmark: _Toc486344758][bookmark: _Toc522112894][bookmark: _Toc15045735]Layout
[bookmark: _Hlk14252673]The following methods of displaying Treemap tiles are available on the “Design” tab:
[image: ]
· [bookmark: _Hlk14252725]Slice and Dice - this layout algorithm divides the space between items, slicing it in the specified direction depending on item value;
· Squarified - the Squarified algorithm arranges tiles so that their width/height ratio will be closer to 1;
· Striped - this algorithm is a modified version of the Squarified algorithm. The difference here is that tiles are drawn side by side as columns or rows;
· [bookmark: _Hlk14252759]
Layout Direction - you can also set a layout direction to specify an arrangement of tiles depending on their sizes:
[image: ]
[bookmark: _Toc486344759][bookmark: _Toc522112895][bookmark: _Toc15045736]Labels
[bookmark: _Hlk14252795]There are two types of labels in a Treemap:
· Tiles Labels
· Group Labels
[image: ]
[bookmark: _Hlk14252841]The Treemap displays labels that contain descriptions for tiles and groups, and provide tooltips with additional information:
[bookmark: _Hlk14252848][image: ]
[bookmark: _Hlk14252859]
Use buttons within the “Tile Labels” / “Group Labels” ribbon groups to manage tile and group labels, respectively. These buttons invoke the drop-down menu, which is similar for all buttons:
[image: ]
[bookmark: _Toc486344760][bookmark: _Toc522112896][bookmark: _Toc15045737]Edit Colors
[bookmark: _Hlk14252893]For a treemap the Color Editor functionality is available. The principle of its functionality is described in abstract 1.7.4.
[bookmark: _Toc486344761][bookmark: _Toc522112897][bookmark: _Toc15045738]Export
[bookmark: _Hlk14252910]Treemap may be exported into PDF, Excel or an image. The ways to do this are described in abstract 1.5.13
[bookmark: _Toc486344762][bookmark: _Toc522112898][bookmark: _Toc15045739] Filter Elements
[bookmark: _Hlk14252930]Filter elements represent a special type of dashboard item that allows you to apply filtering to other dashboard items.
[bookmark: _Hlk14270534]To create a Filter dashboard element, click the icon:
[image: ]
[bookmark: _Hlk14252982]The following filters are available in the drop-down list:
[image: ]
· Combo Box - the Combo Box dashboard item allows to select a value(s) from the drop-down list.
[image: ]
[bookmark: _Hlk14253016]
On the “Design” tab for this filter, there are two ways to select values:
[image: ]
· Standard – allows to select only a single value:
[image: ]
· Checked - allows to select multiple values in the invoked drop-down list:
[image: ]
· List Box - the List Box dashboard item allows to select a value(s) from the list
[image: ]
[bookmark: _Hlk14253050]
On the “Design” tab for this filter, there are two ways to select values:
[image: ]
· Checked – allows to select multiple values in the list box
[image: ]
· Radio - allows to select only a single value in the radio group
[image: ]
In addition, there is a possibility to enable filtering for all elements:
[image: ]
· [bookmark: _Hlk14253278]
Tree View - the “Tree View” dashboard item displays values in a hierarchical way and allows to expand/collapse nodes
[bookmark: _Hlk14253282][image: ]
[bookmark: _Hlk14253290]You can manage the initial expanded state of filter values using the “Auto Expand” button in the “Design” ribbon tab:
[image: ]
[bookmark: _Hlk14253359]Auto Expansion - the tree will be in the expanded state.
For all types of filter available quick search:
[image: ]
[bookmark: _Hlk14253377][image: ]
[bookmark: _Toc522112899][bookmark: _Toc15045740][bookmark: _Toc486344763] Range Filter
[bookmark: _Hlk14253440]The “Range Filter” dashboard element as well as “Filtr” allows to apply filtering to other dashboard elements.
[image: ]
[bookmark: _Hlk14253475]This element displays a chart with selection thumbs that allow you to filter out values displayed along the argument axis:
[bookmark: _Hlk14253482][image: ]
[bookmark: _Hlk14253500]This filter can be used for cross-filter data sources. For this, use the “Cross-Data-Source-Filters” button on the “Data” tab:
[image: ]
[bookmark: _Hlk14253556]You also can not apply end-to-end filters to this element:
[image: ]
[bookmark: _Hlk14253576]You can create your own ranges of data. To do this, use either the context menu (right mouse button) or click on the [image: ] icon in the “Argument” field:
[bookmark: _Hlk14253583][image: ]
[bookmark: _Hlk14253603]As a result, the “Edit Periods” window appears:
[bookmark: _Hlk14253608][image: ]
[bookmark: _Hlk14253620]The list on the left shows the list of ready periods that you can filter:
[image: ]
[bookmark: _Hlk14253631]
In order to add the selected period, use the [image: ] button or simply drag the period in the field on the right:
[image: ]
This period will be added to the right pane of the Edit Periods dialog. The following settings are available for the added period:
· Caption – title name for the period;
· Period - displays the time interval of the date corresponding to the period;
· Default - allows to use the selected period as the default value in the element of the Range Filter panel.

You can create your own period. To do this, use the “Add Custom Period ...” button in the “Edit Periods” window: [image: ]

As a result, a window appears in which you can add the following periods:
[bookmark: _Hlk14253711][image: ]
[bookmark: _Hlk14253725]For the year, quarter and month it is possible to set to display:
· Previous Year/Quarter/Month;
· This Year/Quarter/Month;
· Next Year/Quarter/Month;
· Last Year/Quarter/Month;
· Next Year/Quarter/Month.
[bookmark: _Hlk14253745]
There is also a possibility to create a Custom period:
[image: ]
This period allows to specify a period with user boundaries (“Start” and “End” point):
[image: ]
For start and end points, you can set the following parameters:
· None – the start and end points will be equal to the start and end values from the visible range;
· Fixed – possibility to select a specific value in the calendar;
· Flow – allows to specify a floating period with interval and offset. “Interval” - indicates the interval between the current date and the required date, “Offset” - the number of such intervals:
[bookmark: _Hlk14253807][image: ]
[bookmark: _Toc522112900][bookmark: _Hlk14253851][bookmark: _Toc15045741]
Group
[bookmark: _Hlk14253860]The “Group” dashboard element allows you to merge several elements into a single group.
To create a Group element, click the icon:
[image: ]
[bookmark: _Hlk14253909]Let us have a look at the working principle of this element on the example of two groups.
First, we create two elements of the dashboard - a chart (of a “Spline Area” type) and a filter (of a “Tree View” type). For each of them, fill in fields with appropriate data:
[image: ]
[bookmark: _Hlk14255307][image: ]
[bookmark: _Hlk14255343]
Now create the first group (click the icon of the same name in the toolbar) and drag the chart and filter into it:
[image: ]
[bookmark: _Hlk14255406]Thus, we got a group, elements of which can interact with each other within this group and outside it.
On the “Data” tab:
[image: ]
· [bookmark: _Hlk14255452]The “Master Filter” button allows you to specify whether the current group allows you to filter external dashboard items using master filter items contained within the group. If this option is disabled, master filter items contained within the group can filter only dashboard items from this group;
· The “Ignore Master Filters” button allows you to isolate dashboard items contained within the group from being filtered using external master filter items.
For the first group, let us leave the filter on – “Ignore Master filters”.

Now let us create the second group. It will consist of a chart and two filters (“List Box” and “Combo Box”):
[image: ]
We paint subcategories of the same groups of products in the same color:
[image: ]
Now let us create a filter – “Combo box”:
[image: ]

The second filter will be called “List Box”:
[image: ]
For a “List Box” on the “Data” tab disable “Ignore Master Filters” button:
[image: ]
Create a second group and drag the chart and filters into it:
[image: ]
For this group on the “Data” tab, we also leave an active “Ignore Master Filters” filter.
Thus, we got two independent groups:
[image: ]

The first shows the sales volume of the groups of products depending on the month of the year and country, and the second shows the sales volume of a particular group of products by subcategories:
[image: ]
[bookmark: _Toc522112901]
[bookmark: _Toc15045742]
Images
[bookmark: _Hlk14256530]An image can be one of the elements of a dashboard. To add an image, click the corresponding icon in the toolbar:
[image: ]
[bookmark: _Hlk14256555]An «Interactive Dashboard» allows to create two types of image elements:
[bookmark: _Hlk14256668][image: ]
· Image
· Bound Image
[bookmark: _Toc486344765][bookmark: _Toc522112902][bookmark: _Toc15045743]Image
[bookmark: _Hlk14256574]To add an “Image” element, choose the following sub-item:
[bookmark: _Hlk14256672][image: ]
[bookmark: _Hlk14256681]An empty field appears in the dashboard designer window:
[bookmark: _Hlk14256692][image: ]
[bookmark: _Hlk14256717]
Now, to add an image, go to the “Design” tab and click an “Import Image” icon:
[image: ]
[bookmark: _Hlk14256736]In the opened form, specify the location of the file and click an «OK» button. As a result, the dashboard will look the following:
[bookmark: _Hlk14256743][image: ]
[bookmark: _Hlk14256763]If necessary, the size and location of the image can be changed:
[image: ]
An image may be exported into PDF or an image. The ways to this are described in abstract 1.5.13.
[bookmark: _Toc486344766][bookmark: _Toc522112903][bookmark: _Hlk14256812][bookmark: _Toc15045744]
Bound Image
[bookmark: _Hlk14256881]To add a “Bound Images” item, select the following sub-item:
[image: ]
[bookmark: _Hlk14256889]A new element appears in the designer window:
[bookmark: _Hlk14256893][image: ]
[bookmark: _Hlk14256902]Next, you need to choose how to bind the data to the image by clicking the 
“Options” [image: ] button next to an attribute. The following options will be available in the opened window:
[bookmark: _Hlk14256908][image: ]
· [bookmark: _Hlk14256919]Binary Array – use this mode if images are stored in the data source as byte arrays;
· URI – use this mode to locate images accessible by a predefined URI. In this case, the data source field should return strings that are parts of URIs to these images.
[bookmark: _Hlk14256939]For instance, the URI pattern in the form below specifies the path to the folder containing the required images:
[bookmark: _Hlk14256942][image: ]
[bookmark: _Hlk14256961]Data source field values will be inserted to the position of the {0} placeholder. Thus, the Bound Image maps the current dimension value with the image placed at the specified URI.

For example, let us display flags for each country for the following table:
[image: ]
                                    
[bookmark: _Hlk14257223]
To start with, we will place the files with the corresponding image and name in the folder:
[image: ]
[bookmark: _Hlk14257873]We will create a new “Bound Images” element with the “Country” attribute:
[bookmark: _Hlk14257883][image: ]
[bookmark: _Hlk14258083]
The form of data binding will be filled with the following data:
[image: ]
Now, all is left is to insert the data source field values into the {0} placeholder position:
[image: ]
[bookmark: _Hlk14258136]
As a result, we will get an interactive dashboard in which the table with the “Country” hierarchy will be linked to the image:
[image: ]
[bookmark: _Toc486344767][bookmark: _Toc522112904][bookmark: _Toc15045745] Text Box
[bookmark: _Hlk14258171]“Text Box” can be one of the elements of the dashboard. Click the corresponding icon on the toolbar:
[image: ]
[bookmark: _Hlk14258273]In the designer window, an empty text field appears:
[image: ]
[bookmark: _Hlk14258287]To insert or edit text, go to the “Design” menu tab and click an “Edit” icon:
[image: ]
[bookmark: _Hlk14258365]Or use the corresponding item in the context menu:
[bookmark: _Hlk14258380][image: ]
[bookmark: _Hlk14258390]The text editing form with the following set of tools will appear:
[image: ]
[bookmark: _Hlk14258427]The Text can be exported into PDF or an image.
[bookmark: _Hlk14258442]
The “Text” element can be bound to the data of other dashboard elements. Let us add a “Text” element to the dashboard, and let’s alternately drop the following values of “Product”, “Unit Price” and “Description” in the value field:
[bookmark: _Hlk14258461][image: ]
[bookmark: _Hlk14258923]Now move to the “Design” tab and click an “Edit” button:
[image: ]
[bookmark: _Hlk14258963]In the text field, insert the following data:
[bookmark: _Hlk14258974][image: ]
[bookmark: _Hlk14259018]Then place the cursor at the end of the “Name” text and right-click on it. Select “Insert Field” from the context menu:
[bookmark: _Hlk14259035][image: ]
[bookmark: _Hlk14262149]Now click on the “Select value” field and select the “Product” value:
[image: ]
Repeat the same steps for the “Price” and “Description” fields:
[image: ]
[bookmark: _Hlk14262165]
Now click on the “Edit” button again to exit the edit mode. The following data will be displayed in the “Text Box”:
[image: ]
[bookmark: _Hlk14262266]Let's use filters to make the “Text Box” field more dynamic. Add two filters of the List type with the following fields to the dashboard:
[bookmark: _Hlk14262272][image: ]
[bookmark: _Hlk14262425]
And, finally let’s add the “Images” element with the data binding and we throw the “LargePhoto” in the value field:
[image: ]
[bookmark: _Toc522112905]
[bookmark: _Toc15045746]
Conditional Formatting
[bookmark: _Hlk14769072]For “Grid” and “Pivot” dashboard elements, it is possible to set the format rules.
You can create a new format rule in two ways:
Way 1. Click an “Option” button next to the appropriate dimension/measure:

[image: ]
Way 2. Right-click on the table header:
[image: ]
[bookmark: _Toc486344769][bookmark: _Toc522112906][bookmark: _Toc15045747]
Format Rule: Value
[bookmark: _Hlk14769354]Value can be one of the highlight rules:
[image: ]
Let us have a look at it on an example of the pivot table:
[image: ]
[bookmark: _Hlk14769570]
Let us select the totals of those product categories for which the values of the “Sales Amount” measure are more than $ 1 million:
[image: ]
[bookmark: _Hlk14769650]The following form appears:
[image: ]
This form contains the following parameters specific to Pivot:
· Format values that are greater than… – set value;
· Appearance/Icons – the “Appearance” tab allows you to choose the predefined background color/font, the “Icons” tab allows you to add the predefined icon;
· Intersection mode – the level at which the highlight will be applied. The levels can be as follows:
· Auto – identifies the default level. For the Pivot dashboard item, auto identifies the “First Level”;
· First level – first level values are used to apply conditional formatting;
· Last level – the last level values are used to apply conditional formatting;
· All levels – all pivot data cells are used to apply conditional formatting;
· Specific level – values from the specific level are used to apply conditional formatting.
· Row/Column dimension - if you specified the Intersection mode as “Specific Level”, use the “Row dimension” and “Column dimension” combo boxes to set the specific level;
· Apply to – to which element (measure, hierarchy) of the Pivot table the conditional formatting should be applied;
· Apply to row/column – apply to the entire row / to the entire column.
Fill out this form as follows:
[image: ]
As a result, the “Pivot” table will look the following:
[bookmark: _Hlk14769814][image: ]
[bookmark: _Hlk14769823]To edit an existing highlight rule, click the “Options” icon next to the measure:
[bookmark: _Hlk14769828] [image: ]
[bookmark: _Hlk14769862]
In the window that appears, double-click the rule or click an “Edit” button:
[image: ]
To delete the format rule, select the necessary format rule in the list in the “Edit Rules” window and click the “Delete” button: 
[image: ]

If necessary, the rule can be temporarily disabled by unchecking the corresponding rule:
[image: ]
[bookmark: _Toc486344770][bookmark: _Toc522112907][bookmark: _Toc15045748]Format Rule: Top N / Bottom N 
[bookmark: _Hlk14769911]The “Top-Bottom” format conditions allow you to highlight a specific number of topmost/bottommost values. You can specify this number as an absolute or percent value:
[bookmark: _Hlk14769934][image: ]
[bookmark: _Hlk14769973]
For example, let us select 4 quarters for which the “Sales Amount” measure values were the worst. Select the type of “Bottom N” highlight and fill out the form as follows:

[image: ]

Pivot will look like this:
[image: ]

Now let us check those product categories, the profit from which amounted to 90% of the total profit. For this, select the “Top N” highlight type and fill out the form as follows:
[image: ]

We get the following Pivot:
[image: ]
Two product categories – “Bikes” and “Components” - gave 90% out of all profits.
[bookmark: _Toc486344771][bookmark: _Toc522112908][bookmark: _Toc15045749]Format Rule: Average
[bookmark: _Hlk14770683]The “Average” format conditions allow you to highlight values above or below an average value:

[bookmark: _Hlk14770693][image: ]
[bookmark: _Toc486344772][bookmark: _Toc522112909][bookmark: _Toc15045750]
Format Rule: Expression
[bookmark: _Hlk14770732]An “Expression” format condition allows you to use complex conditions to apply formatting: 
[image: ]
[bookmark: _Toc486344773][bookmark: _Toc522112910][bookmark: _Toc15045751]
Format Rule: Icon Ranges
[bookmark: _Hlk14770763]Icon “Ranges” allow you to use predefined or custom sets of icons to apply conditional formatting to different ranges of values:
[bookmark: _Hlk14770768][image: ]
[bookmark: _Hlk14770783]For example, let us select the 4-range highlight for the “Gross Profit” measure:
[bookmark: _Hlk14770793][image: ]
[bookmark: _Hlk14770821]
The following options are available in the appeared window:
[image: ]
· Format style – the “Format Style” combo box allows you to change the icon set used to apply formatting;
· Use % ranges - the “Use % ranges” check box specifies whether the percent or absolute scale is used to generate ranges;
· Range field with set values:
[image: ]

Use the «Add» and «Delete» buttons to add new ranges or delete the selected range respectively. Note that new range is added below the selected range:
[image: ]
To change the icon displayed for values corresponding to the specified range, click the button next to the required icon and select a new icon:
[image: ]
· Intersection mode – the level at which the highlight will be applied. The levels can be as follows:
· Auto –  identifies the default level. For the Pivot dashboard item, Auto identifies the “First Level”;
· First level – first level values are used to apply conditional formatting;
· Last level –  the last level values are used to apply conditional formatting;
· All levels – all pivot data cells are used to apply conditional formatting;
· Specific level – values from the specific level are used to apply conditional formatting.
· Row/Column dimension - if you specified the Intersection mode as “Specific Level”, use the “Row dimension” and “Column dimension” combo boxes to set the specific level;
· Apply to – to which element (measure, hierarchy) of the Pivot table the conditional formatting should be applied;
· Apply to row/column – apply to the entire row / to the entire column.


Fill in the form with the following data::
[image: ]

As a result, the pivot table will look the following:
[image: ]
[bookmark: _Toc486344774][bookmark: _Toc522112911][bookmark: _Toc15045752]Format Rule: Color Ranges
[bookmark: _Hlk14770939]To format values according to the required condition, click the data item menu button, select “Add Format Rule”| “Color Ranges” and choose the required color set:
[image: ]
[bookmark: _Hlk14770963]
The working principle is the same as for the “Format Rule: Icon Ranges” highlight rule (abstract 8.18.5):
[bookmark: _Hlk14770978][image: ]
[bookmark: _Toc486344775][bookmark: _Toc522112912][bookmark: _Toc15045753]
Format Rule: Gradient Ranges
[bookmark: _Hlk14771066]“Gradient Ranges” allow you to use predefined color gradients to apply conditional formatting to different ranges of values. You can also use specific colors to generate custom gradients.:
[image: ]
[bookmark: _Hlk14771098]
The form of the gradient highlight looks the following
[image: ]
The following options will be available in the appeared window:
· Number of ranges – “Number of ranges” allows you to specify the number of ranges used to classify values. Click the “Generate Ranges” button to generate a new gradient scale according to the specified number of ranges;
· Use % ranges - the “Use % ranges” check box specifies whether the percent or absolute scale is used to generate ranges;
· 
Range field with specified ranges:
[image: ]
· Intersection mode – the level at which the highlight will be applied. The levels can be as follows:
· Auto – identifies the default level. For the Pivot dashboard item, Auto identifies the “First Level”;
· First level – first level values are used to apply conditional formatting;
· Last level – the last level values are used to apply conditional formatting;
· All levels – all pivot data cells are used to apply conditional formatting;
· Specific level – values from the specific level are used to apply conditional formatting.
· Row/Column dimension - if you specified the Intersection mode as “Specific Level”, use the “Row dimension” and “Column dimension” combo boxes to set the specific level;
· Apply to – to which element (measure, hierarchy) of the Pivot table the conditional formatting should be applied;
· Apply to row/column – apply to the entire row / to the entire column.

[bookmark: _Toc486344776][bookmark: _Toc522112913][bookmark: _Toc15045754]
Format Rule: Bar
[bookmark: _Hlk14771157]The “Bar” format condition allows you to visualize numeric values using bars. You can also paint bars corresponding to positive and negative values using different colors:
[image: ]
This dialog allows you to change the following options specific to the “Bar” format condition:
[image: ]
· Min/Max – by default, lengths of the shortest and longest bars correspond to minimum and maximum values, respectively. If necessary, you can specify values corresponding to the shortest and longest bars manually. To do this, change the type of minimum/maximum value from “Automatic” to “Number or Percent”, and specify the required values;
· Style Settings – “Style Settings” and “Negative Style Settings” allow you to specify style settings used to color data bars corresponding to positive and negative values, respectively;
· Intersection mode – the level at which the highlight will be applied. The levels can be as follows:
· Auto – identifies the default level. For the Pivot dashboard item, Auto identifies the “First Level”;
· First level – first level values are used to apply conditional formatting;
· Last level – the last level values are used to apply conditional formatting;
· All levels – all pivot data cells are used to apply conditional formatting;
· Specific level – values from the specific level are used to apply conditional formatting.
· Row/Column dimension - if you specified the Intersection mode as Specific Level, use the “Row dimension” and “Column dimension” combo boxes to set the specific level;
· Apply to – to which element (measure, hierarchy) of the Pivot table the conditional formatting should be applied;
· Apply to row/column – apply to the entire row / to the entire column;
· Allow negative axis – the “Allow negative axis” option allows you to specify whether negative data bars are displayed in the direction opposite to the positive data bars;
· Draw axis – the “Draw axis” option specifies whether to draw the vertical axis between positive and negative data bars;
· Show bar only – the “Show bar only” option specifies whether to show bars without corresponding values.
Let us look at this type of highlight on the example of the “Pivot” table:
[image: ]

Let us add a highlight rule for the “Reseller Gross Profit” measure:
[image: ]
[bookmark: _Hlk14771443]
Fill out the form as follows:
[image: ] [image: ]

As a result, we will get the following table:
[image: ]
[bookmark: _Toc486344777][bookmark: _Toc522112914][bookmark: _Toc15045755]Format Rule: Bar Color Range
[bookmark: _Hlk14771512]“Bar Color Ranges” allow you to visualize numeric values using bars whose colors are contained in the specified color set:
[image: ]

This dialog allows you to change the following options specific to “Bar Color Ranges”:
[image: ]
The following options will be available in the appeared window:
· Format style – the “Format Style” combo box allows you to change the color set used to apply formatting;
· Use % ranges - the “Use % ranges” check box specifies whether the percent or absolute scale is used to generate ranges;
· 
Range field with specifies values:
[image: ]
Use the «Add» and «Delete» buttons to add new ranges or delete the selected range respectively. Note that new range is added below the selected range:
[image: ]
To change the icon displayed for values corresponding to the specified range, click the button next to the required icon and select a new icon:
[image: ]
· Intersection mode – the level at which the highlight will be applied. The levels can be as follows:
· Auto – identifies the default level. For the Pivot dashboard item, Auto identifies the “First Level”;
· First level – first level values are used to apply conditional formatting;
· Last level – the last level values are used to apply conditional formatting;
· All levels – all pivot data cells are used to apply conditional formatting;
· Specific level – values from the specific level are used to apply conditional formatting.
· Row/Column dimension - if you specified the Intersection mode as “Specific Level”, use the “Row dimension” and “Column dimension” combo boxes to set the specific level;
· Apply to – to which element (measure, hierarchy) of the Pivot table the conditional formatting should be applied;
· Apply to row/column – apply to the entire row / to the entire column;
· Allow negative axis – the “Allow negative axis” option allows you to specify whether negative data bars are displayed in the direction opposite to the positive data bars;
· Draw axis – the “Draw axis” option specifies whether to draw the vertical axis between positive and negative data bars;
· Show bar only – the “Show bar” only option specifies whether to show bars without corresponding values.
[bookmark: _Toc522112915][bookmark: _Toc15045756]Format Rule: Bar Gradient Ranges
Bar Gradient Ranges allow you to visualize numeric values using bars whose colors are contained in the specified color gradient:
[bookmark: _Hlk14771542][image: ]
[bookmark: _Hlk14771562]
This dialog allows you to change the following options specific to “Bar Gradient Ranges”:
[image: ]
· Number of ranges – “Number of ranges” allows you to specify the number of ranges used to classify values. Click the Generate Ranges button to generate a new gradient scale according to the specified number of ranges;
· Use % ranges - the “Use % ranges” check box specifies whether the percent or absolute scale is used to generate ranges;
· 
Range field with specified values:
[image: ]
[image: ]
· Intersection mode – the level at which the highlight will be applied. The levels can be as follows:
· Auto – identifies the default level. For the Pivot dashboard item, Auto identifies the “First Level”;
· First level – first level values are used to apply conditional formatting;
· Last level – the last level values are used to apply conditional formatting;
· All levels – all pivot data cells are used to apply conditional formatting;
· Specific level – values from the specific level are used to apply conditional formatting.
· Row/Column dimension - if you specified the Intersection mode as “Specific Level”, use the “Row dimension” and “Column dimension” combo boxes to set the specific level;
· Apply to – to which element (measure, hierarchy) of the Pivot table the conditional formatting should be applied;
· Apply to row/column – apply to the entire row / to the entire column;
· Allow negative axis – the “Allow negative axis” option allows you to specify whether negative data bars are displayed in the direction opposite to the positive data bars;
· Draw axis – the “Draw axis” option specifies whether to draw the vertical axis between positive and negative data bars;
· Show bar only – the “Show bar” only option specifies whether to show bars without corresponding values.
[bookmark: _Toc486344779][bookmark: _Toc522112916][bookmark: _Toc15045757]
Top N
[bookmark: _Hlk14771617]The “Top N” feature allows you to display only a limited number of values that correspond to the highest or lowest values of a particular measure
Let us consider the working principle of the given functionality on an example of a grid (the highlight rule - line color range):
[image: ]

We display only 7 subcategories with the best values of “Order Count” measure:
[image: ]
The following parameters are available in the form:
[image: ]
· Enabled – enables/disables this functionality;
· Mode – specifies whether top or bottom values should be displayed;
· Count – the number of values to be displayed;
· Measure – the parameter according to which the top or bottom values will be determined.


Fill out the form as follows:
[image: ]
As a result, the table looks the following:
[image: ]

And now let us add the “Category” dimension to the columns and we get the following result:
[image: ]
Now we have 7 best “Order Count” measure indicators for each product category.
[bookmark: _Toc486344780][bookmark: _Toc522112917]
[bookmark: _Toc15045758]
Sorting
[bookmark: _Hlk14771783]Let us sort the table obtained earlier in the decreasing order of the “Order Count” measure. For this, click in the right corner of the table next to an icon:
[bookmark: _Hlk14771791][image: ]
[bookmark: _Hlk14771805]The column with the Order Count measure is sorted in a descending order:
[image: ]
Having clicked again, we get the opposite result (an increase of the “Order Count” measure).
[bookmark: _Hlk14771830]
To sort the hierarchy alphabetically, you need to open the context menu:
[image: ]
By selecting the “Sort Descending” method, we get a table with category names sorted in a descending order:
[image: ]

If necessary, you can disable sorting:
[image: ]
OLAP Sorting specific:
[image: ]
· (Value) – sorting is performed by member values;
· (Display Text) – sorting is performed by captions associated with members;
· (Key) – sorting is performed by member keys;
· (ID) – sorting is performed by member IDs.
[bookmark: _Toc15045759][bookmark: _Toc486344781][bookmark: _Toc522112918]Formatting Data
[bookmark: _Toc15045760]Formatting Numeric Values
[bookmark: _Hlk14771898]You can change the data format. This functionality is available on the “Dashboard Designer toolbar”:
[image: ]

To specify a format for numeric values, select “Format” from the data item menu:
[image: ]
[bookmark: _Hlk14771949]This invokes the “Numeric Format” window:
[bookmark: _Hlk14771939][image: ]
[bookmark: _Hlk14772734]
Types of formats can be as follows:
[image: ]
Other format settings are in effect for only specific format types:
· Unit – the unit to which values should be converted;
· Precision – the number of fractional digits that should be displayed;
· Currency – defines the currency sign and format settings that should be used to display currency values;
· Culture – for currencies used in a region with several cultures, specifies the culture that defines format settings
· Include group separator – specifies whether or not separators should be inserted between digit groups.
[bookmark: _Toc15045761]
Formatting Date-Time Values
[bookmark: _Hlk14772769]For date and time values, this functionality has the following parameters:
[image: ]
[bookmark: _Toc15045762]Currency Formatting Specifics
[bookmark: _Hlk14772826]The «Interactive dashboard» allows you to specify a currency format at two levels: for the entire dashboard and for individual data items:
· Data Item Currency – to specify which currency to use for a particular data item, select “Format” from the data item menu:
[image: ]
In the “Numeric Format” dialog, select “Currency” in the “Format type” field and use the “Currency” combo box to select the required currency:
[image: ]
For regions with several cultures, you can also select the culture that will be used to format currency values:
[image: ]

You can also apply the default dashboard currency by selecting «Use dashboard settings» in the “Currency” field:
[image: ]
· Dashboard Currency
You can also specify the default currency for the dashboard. This setting will be applied to dashboard items that have no currency defined.
To set the dashboard currency, click the “Currency” button on the toolbar:
[image: ]
This invokes the Dashboard Currency window. In this window, select the required currency using the “Currency” combo box:
[image: ]

[bookmark: _Toc15045763]Parameters
[bookmark: _Hlk14772923]The parameter is a dashboard element that allows to dynamically influence the “Expression” highlight rule.
In order to create a parameter, click the toolbar icon:
[image: ]
The following window opens:
[image: ]


To add the parameter, click the «Add» button. The following parameters are displayed in the window:
[image: ]
· Visible – specifies whether or not the parameter editor is visible in the dashboard Parameters dialog;
· Allow Null –specifies whether or a not null value can be passed as a parameter value; 
· Allow Multiselect – specifies whether or not multi-selection is enabled for the current parameter. The following limitations are applied to parameters with multi-selection enabled.
· Use the “is any of” or “is none of” operators to pass a multi-select parameter to a filter criteria or to the Expression format condition.
· Use the “In” or “Not In” operators to pass a multi-select parameter to a calculated field expression.
· Custom SQL queries do not support multi-select parameters.
· Stored procedures used in SQL and Entity Framework data sources do not support multi-select parameters.
· Description – specifies the parameter's description displayed;
· Look-Up Settings – specifies the parameter's look-up editor settings;
· Type – specifies the parameter type;
· Value – specifies the default parameter’s value(s).
Note that when “Allow Multiselect” is set to “true”, the “Value” option allows you to select multiple parameter values;
· Name – Specifies the parameter name.
· A name can contain letters, numbers and underscores.
· A name cannot contain spaces.
· A name cannot be an empty string.
· The dashboard cannot contain parameters with the same name.
· Names are case-sensitive. For example, you can create the names Parameter and PARAMETER.

Let us create a setting that highlights the “Reseller Sales Amount” value of more than $500,000, but less than $ 1 million for all product subcategories.
First, we add a table with the following values:
[image: ]

Create two parameters and fill in the fields as follows:	
[image: ]
[image: ]

For “Reseller Sales Amount”, create an “Expression” highlight rule with the following parameters:
[image: ]
As a result, the first parameter from the list is displayed in the value field:
[image: ]

Similarly, double-click the second value field:
[image: ]
The first parameter will be displayed again, click it and select the “Sales2” parameter in the opened list:
[image: ]

It is only left to choose the color of highlight on the panel:
[image: ]

Now all the values of the “Reseller Sales Amount” measure that are higher than $ 500 000 but lower than $ 1 million for all product subcategories are highlighted in the table:
[image: ]
Now let us change the range of values: Sales1 = $ 200 000, and Sales2 = $ 2 million.

For this, click the “Options” icon in the toolbar:
[image: ]
In the opened window enter the corresponding values for each parameter:
[image: ]

As a result, we get a table where all the values of “Reseller Sales Amount” measure for more than $ 200 000 but less than $ 1 million are highlighted:
[image: ]
[bookmark: _Toc486344782][bookmark: _Toc522112919]
[bookmark: _Toc15045764]
Hidden data items
Each dashboard element in the “Data Items” field contains an additional
field – “Hidden Data Items”:
[image: ]
Elements of this field can be used as a context.
Let us consider it on an example of one of the previous tables:
[image: ]

We display the 7 best values of the “Order Count” measure for each product category only for year 2018. For this, drop the “Calendar Year” hierarchy into the “Hidden Data Items” field:
[image: ]
Now, from the context menu (by a right-click), select “Edit Filter” icon:
[image: ]
In the drop-down list, select the “Calendar Year” hierarchy:
[image: ]
And then specify the year:
[image: ]

Now the table displays the 7 best values of the “Order Count” measure for each product category for year 2018 only:
[image: ]
[bookmark: _Toc522112920][bookmark: _Toc15045765]
Aggregations
In the interactive dashboard, the following aggregate functions are available:
[image: ]
Count – returns the number of values
 Count Distinct – returns the number of distinct values
 Sum – returns the sum of all values
Min – returns the minimum value across all records
Max – returns the maximum value across all records
Average - Returns the average of all the values in the expression.
StdDev - Mean Square Deviation
StdDev P - dispersion
Var - Non-shifted dispersion
VarP – median
Mode
[bookmark: _Toc522112921][bookmark: _Toc518314179][bookmark: _Toc15045766]
Calculated Members
The «Interactive Dashboard» allows to add the following calculated elements based on the ready-made measures:
[image: ]
· Percent of Column Grand Total
· Percent of Row Grand Total
· Percent of Grand Total
· Running Summary along Columns
· Running Summary along Rows
· Difference along Columns
· Difference along Rows
· Percentage Difference along Columns
· Percentage Difference along Rows
· Rank along Columns
· Rank along Rows
· Rank along Cells
You can create your own computational element:
[image: ]

As a result, “Customize Calculation” form appears:
[image: ]
[bookmark: _Toc522112922][bookmark: _Toc15045767]Running Total
[bookmark: _Hlk14773330]The “Running Total” calculation can be used to compute a cumulative total for the 
specified measure:
[image: ]
Running along – the direction that is used to calculate running totals;
· Summary function – specifies a summary function used to apply calculation.
[image: ]
 In the table below, we can see sub-total sales for all months:
[image: ]
[bookmark: _Toc522112923][bookmark: _Toc15045768]Moving Calculation
The “Moving calculation” uses neighboring values to calculate a total:
[image: ]
· Moving along – specifies a window and direction used to apply a calculation;
· Summary function – specifies a summary function used to apply calculation.

Start/End offset - initial and final offsets from the current value in process:
 [image: ]
In the table below, we can see the moving average for all months with an initial offset of -2 and a final offset of 0:
[image: ]
[bookmark: _Toc522112924][bookmark: _Toc15045769]Difference
[bookmark: _Hlk14788945]The “Difference” calculation can be used to compute the difference between measure values:
[image: ]
Calculate along – specifies a window and direction used to calculate differences;
Difference from – select value
· Previous
· Next
· First
· Last
[bookmark: _Hlk14788990]Percentage Difference – show the percentage difference.
[image: ]
In the table below, we can see an absolute value of the difference between the months (Difference from - Previous):
[image: ]
[bookmark: _Toc522112925][bookmark: _Toc15045770]Percent Of Total
[bookmark: _Hlk14789043]A calculation is used to compute a percentage of the total for the specified measure:
[image: ]
Percent of total - specifies a window and direction used to apply a Percent of Total calculation.
[image: ]
Below we can see the table that displays the contribution of individual monthly sales to total sales:
[image: ]
[bookmark: _Toc522112926][bookmark: _Toc15045771]Rank
[bookmark: _Hlk14789094]Use the “Rank” calculation to compute rankings for the specified measure:
[image: ]
Rank along – specifies a window and direction used to rank values;
Rank type
· Unique
· Competition
· Dense
· Modified
· Percentile
Order - ranking order
· Ascending
· Descending
[image: ]
Below we can see the table that displays the ranking of sales for particular years in descending order: 
[image: ]
[bookmark: _Toc522112927][bookmark: _Toc15045772]Expression
[bookmark: _Hlk14789140]With such choice, you can create your own expression using the necessary functions.
To do this, click the “Edit in Expression Editor” button:
[image: ]

In the window that appears, write the appropriate expression:
[image: ]
[bookmark: _Toc522112928][bookmark: _Toc15045773]
Interactive Dashboard Filtering
[bookmark: _Hlk14789190]The «Interactive Dashboard» allows you to use any data aware dashboard item as a filter for other dashboard items:
[image: ]
To reset filtering, use the “Clear Master Filter” button (the [image: ] icon).
You can prevent specific dashboard items from being affected by “Master Filters”. To do this, use the “Ignore Master Filters” button:
[image: ]
[bookmark: _Toc15045774]
Dashboard Title
[bookmark: _Hlk14789316]The “Dashboard Title” is located at the top of the dashboard surface. It can contain text or image content:
[image: ]
You can change title settings by clicking the “Title” button:
[image: ]
[bookmark: _Hlk14789359]
This dialog allows you to specify the following options:
[image: ]
· Visible – specifies whether or not the dashboard title is visible;
· Show Master Filter state – specifies whether or not to show the state of master filter items in the dashboard title;
· Text – title text;
· Alignment – specifies the alignment of the dashboard title;
· Images – allows you to specify the image displayed within the dashboard title;
When you hover over the filter icon ([image: ]), all master filters applied to the dashboard are displayed in the invoked popup:
[image: ]
[bookmark: _Toc15045775]
Dashboard Item Caption
[bookmark: _Hlk14789431]The title of the dashboard element is located at the top of the dashboard and contains the following information:
[image: ]
To edit the title of the dashboard element, select the Edit names item in the context menu of the element:
[image: ]
[bookmark: _Toc15045776]Dashboard Items Layout
[bookmark: _Hlk14789474]The “Dashboard Designer” provides the capability to arrange and resize dashboard items and groups in various ways, using simple drag-and-drop operations:
[image: ]
[bookmark: _Hlk14789510]
You can change the position of a dashboard item by using drag-and-drop:
[image: ]
[bookmark: _Toc15045777]Undo and Redo Operations
[bookmark: _Hlk14789562]In the «Interactive Dashboard» it is possible to undo and redo the actions performed on the dashboard. To undo/redo the last action, use the following buttons:
[image: ]
To undo/redo several actions at once, click the arrow next to “Undo” / “Redo” button and select the actions in the list that you want to undo/redo
[image: ]
[bookmark: _Toc15045778]Automatic and Manual Updates
[bookmark: _Hlk14789606]The option “Automatic” is available on the toolbar of the «Interactive Dashboard»:
[image: ]
If this option is enabled, then all changes to the page structure will immediately display updated data. If this option is disabled, you can first modify the page as you like, and then click the button on the Button toolbar to send a request to the server for data:
[image: ]
[bookmark: _Toc15045779]
Interactive shared dashboards
After you created a number of dashboards, you can share them. To do this, right-click on the name of the dashboard and select an appropriate menu item:
[image: ]
After that, other users and administrator will see your page in the list of shared dashboards.

1

image3.png
8 Business Analysis Tool (Report Moduie) - http: flocalhost:8204/ o @B =
fpplicatin  Modue  Reports  Report | Dashboard | View Tooks  Hep
‘H @t G EF ¢ .
42 (version 1] o Add x
© oo™
P search, Dashboard B
P | Deete
(8 Admin's Deete AlEUtTHS  try - Reseller Order Quantity vs Internet .. 1) 2 I Specaty ikeshop I Vloe AddedReseler
Delete Al A warehouse
Canada
Dasrbozd vp | @ Refreshats 295 L 3m
y . oste 555 186
e | Do Eew 819% | Y 69.14%
- SN s -
Germany U e ""
193 735
61K s g am
bz v 2376% Y 12.22% T
—— s —— s 8
i - D 1sm
5
Subcate.. | ReslerOrce... | Resler s, | Reseler Orcer Quantty venter.. | @ 1o
Bi-Shorts E) st g
E siosc 65.29% A B
s $7.48 22%W o
248 $51.8K -~
295 966K
oo s 0% A o ]
250 $9.38K Bikes. ‘Components.
a1 sx 2%553% A v Accessories Clothing

Logn: john | Server: htp:/focahost:8204/





image91.png




image92.png




image93.png
th %
Reseler Sl A.. Interet Order Quanty v... ReselerOrder Count
i AR
o o
Ex| | 5 et a7
sux| Tt

Min = $925.
Max = $255K





image94.png




image95.png
Chart 1

e




image96.png
DATA ITEMS.

Values (Pane 1)

thil

I cvaois [ cvaoss [ cvao [ cvans

€
El
3
£
<
8
©
3

Accessores Clothing ~ Components




image97.png




image98.png
Beties Typel | Common Options | Point Label Options.

Tucrorpame:

Touan





image99.png
TucTorpane:





image100.png
[ Plot on secondary axis:
Ignore empty paints

Show point markers.




image4.png




image101.png
Show for zero values:

Positon:

ide overlapping labels

Outsice.





image102.png
Show for zero values:

Positon:

ride overlapping abels -
Default -
o

Outsice.





image103.png
Chart 1

100%

0%

0%

70%

0%

0%

r Sales Amount

0%

30%

K
g
&

20%

0%

0%

Accessories

Bikes

Clothing

Componerts




image104.png
DATA ITEMS
Values (Pane 1)

Reseler Sales Amount

Valve

Arguments




image105.png
Series Options.

SenesTwe‘ ‘Common Options Dpoint Label Optons

[ Plot on secondary axis:
[ gnore empty points

L how point markers:




image106.png
Series Options ]

Common Optiond[_Point Label Optons 1)

Point label options

Content: Value -

Repositon overlapping labels





image107.png
58

s §F 0§ F

Reseller Order Count  Reseller Sales Amount E

Accessores





image108.png




image109.png
X-Axis Settings

[ Reversel
[ Enable zooming
¥ shom s
] shom e
© Defmit et
E——

] Limit visile points

Category





image110.png
Reseler Sales Amount.

0





image5.png
8
| vame |

E NW%EiIii\—/Om

Undo  Redo

Pivot

Fie History

Gid  Chart Scatter Pies

“Chart

Gle
o (O
e

Data Source:
dvertirs Viorks I

823 =

~ (@ Adventure Works =
+ gl Measures
+ I Account
+ 1 customer
s oo
» I Delvery Date
+ 1 Department
+ I, Destnaton Cure...
» g, Employee
+ g, Geography
+ 1, Intemetsdesor...
» 1 Orgarizaton
» 1, Product
+ I Promotion
» I, Reseler
+ I, Reseler Sdes Ord...
+ 1, saes Channel
+ I, salesReason
+ I, sees Summary Or.

+ 1 Ssls Tertory
T Grenarin

Reseller

To add a dashboard item to your dashboard, clck the corresponding button in the Ribbon or the Toobar





image111.png
\ﬁ\“/

R Y &

Show Caption | EditNames

Rotate X Y-
Settngs  Settings

Diagram

Legend

Series Type.

_!|/Gobal | Local et colors
=1/ Colors | Colors:

(e x]

[

Coloring




image112.png




image113.png
=
=
=
=

El

=
=]
=
]

Inside Horzontal
£l
OutsdeHorzarta

£l
e Verbca

=
[l

ol

i[

[0 O
:|i





image114.png
Home. Design

\ﬁ\“/ R ® B[ E

Show Caption | EditNames | Rotate X-Axs  Y-Axis ||ShowLegend
Settngs  Settings

e lx]

Gobal | Local  EditColors
Colors | Colors

Common Digram Legend Coloring




image115.png
Bar

ol [odll] (0§
Point /Line

# [ =
S
e

Range

i

Bubble

Financ:

Y

[





image116.png
L] GaTES 0013

. |

(8| »

Show Caption | EditNames | Rotate X-Axis  Y-Axis | Show Legend
Settings  Settings

Common Digram

e lx]

Sebd | Lol dtcrs

[ - ‘

Series Type Coloring





image117.png
Dashboard Designer

v
BTRdi Q@ WY EeE X NP S [€@ = I
Redo Pivot  Grid  Chart Scatter Pies Gauges Carc Treemap Range Filter Images TextBox Group | Duplicate Delete Remove Transpose Convert Title  Currency Edit Automatic | Updat=  Parameters
s e ‘ e e ‘

Dashboard

H
soe | o

Fie History Insert Ttem




image118.png
Global Color Scheme

‘Adventure Works: Calendar Year | Measurehiames. ][ pekte
Vaue < Color
€1 2015 | Reseler Order Count v

€Y 2015 | Reseler Sales Amount
€1 2016 | Reseler Order Count
€1 2016 | Resellr Sales Amount
€1 2017 | Reseler Order Count
€1 2017 | Resellr Sales Amount
€1 2018 | Reseler Order Count
€1 2018 | Resellr Sales Amount

B paletic index: 7

W fuomstc

Palette Colors

B Wore Colors..





image119.png
GHartd oole:

Dashboard Designer
one. M
- 18 Treemap. (] tmages ~
8- B ale]0 oI 2
S|t & % e B s a5

P riter Benents + [ Growp

Fie

History Insert





image120.png
L] ASiCiE Dashboard Designer (B[ x]
Home | Data &
E & - % @ iii ° @ reemap. (88 images v Dupiicate: = [

. ; S @regerter & Teazoc | X belte L | Gomes ©
Save o G Chart Scatter Pes Gages Cards o
= - P Fiter Bements ~ [ Growp. & RemoveDataltems @7 | [ EditCoors [
Fie | ristory Insert Iiem Dashboard
Data Souree Scatter
Adventureworks

20 8

- 3 Adventre Works
» il vessres
+ L Account
+ I Customer
» 1 oate
+ . DelveryDste
+ . Department
+ . estnstion Curency
+ 8, Employes.
+ I Geosraphy
+ [ Intemet sses Orcer
» 1 organzaton
+ I product
+ 1 promoten
+ I Reseler
] Reseler soles rder
+ [ SslesChannel
+ [ SsksResson
+ . Sales Summry Orce
+ 1 Ssls Tertory

+ [ seenario

HIDDEN DATA ITEMS
Dimensions.

Dimension
Measures.

Measure.

Scatter Chart 1





image6.png
L] Dashboard Designer
= A == W 2 5 AB% e | [
H = B ali OOBIREY ¥ a v @2 & |G [
v v Chart. Filter  Elements ¥ Updates.

Date Souree Reseller

1881 8%
» ol Measures
» & Account
» 1, customer
» & pate

+ 1, Deivery Date

+ 1 Department

+ 1, Destiaton Curre.
» 1, Emplovee

+ 1, Geoaraphy

+ 1, Intemet ssles .
+ I Organization

» 1, Product

+ I Promotion

» 1, Reseler

+ I Reseler sdes ord
+ 1, saes Channel

+ I, salesReason

+ 18] Sales summary Or.
+ 1, sees Tertory

W Seonin





image121.png
Data Source: ETLIES

Adventretiors 7 ks
82/ 8 Sales Amount
() Adventure Works -
0%
%
0%
£
o
S
>
£ am
[ Avgument S
+ 1] Internet ssles Orcer... S o
+ 18, organization — e}
e HIDDEN DATA ITEMS @ 2%
» [ Financal Dimensions P
» [ History ‘ o .
» [3 Stodking 10%
88]categery Measres
] 3

B8 Large Photo [
B8 Model Name





image122.png
DATA ITEMS

Xaxis

F I A

<
2
5
>





image123.png
‘Scatter Chart 1

Gross Profit Margin
I

§

§

§

&

th &l

I Accessores [ Bikes [ Clothing [ Componerts





image124.png
<
2
5
>
2
&
8
&

L) Dashboard Designer
Home >
% % TR % L)

EditFiter Clear | Single Master  Multiple Cross-Data-Source  Ignore Master

Fiter . MasterFter Fierng Fiers
Fiterng interactuty Interacvity setings
Data Source DATATTEMS
Adventretiors 7 ks
82/ 8 Sales Amount
+ 1 Department q .. I Accessories [l Bikes [l Clothing [l Components
» 1€ Destiaton Curency
gt
+ g, Geography
+ 1€ Intemet sdes order... ||| SN
i o
- 12 product





image125.png
‘Scatter Chart 1 - Bikes

M s

£ 8 &

LBl 11§01 $50.5)

ke

£

Sales




image126.png
DATA TTEMS

g 8 2

UIBeN 1404d

Xaxis

Vaxis

Gross Profit Margin

Gross Proft

Hacoe e s
\

Wesases

f




image127.png
‘Scatter Chart 1 - Bikes

Gross Profit Margin

5%

1%

0%

th o

I Mountaingikes [l Roadbikes [l Touring Bikes





image128.png




image129.png
Rotate X-As  Y-As
Settngs Setings





image130.png
=AY
e 2 B 8

Local EditColors
foree )

Legend Coloring.





image7.png
B - 5 B

Save | @ Redo Pvot  Gid  Chart

G
Fie History.

Data Source
Adventure Wiorks
‘Adventure Works
aw

[ Adventure Works =

> il Measures

e e .




image131.png
Argument
Fide overlapping labels





image132.png
Export To PDF - Scatter Chart 1

© et
PageLayout: O Landscape:

O auto
sie: Letter
ShowTite: ]
Tite: Scatter Chart 1

O None:
SzeMode: O sStretch

© zoom
Inciude: [ClFiters.

[l parameters
Positon: Belon,
Resst Bxport ||





image133.png
Dashboard Designer

Home | Data

E o % ol & @ @ Brems (6 e

o s oty PRt rexnc
ot ¢ Sater P o
Gt P Fiter ements < (5] o

Insert

o~

Fie | Hstory





image134.png
Data Source.

AdventureWorks
1928z &

~ @ Adventure iorks
+ ulll Measures
+ I Account
+ 1 Customer
B oate Gross Profit Margin
12, beveryDate
+ 1 Department
+ 1, Destiaton Currency
+ g, Employee
+ g, Geography
+ 18, Intemnet Ssles Order Det...
+ I Organization
~ B product

» 3 Finencil

5

&5 Category
B8 Large Photo
58 Model Name
88 Product
58 ProductLine





image135.png
Components:

Components:
1627 %

[Clothing: 25.00

Components:
550%

Bikes: 10.57 %

Components:

facting 2 R B2





image136.png
@ x & Remove Data Items

Dupicate Delete

S ComertTo~

Ttem




image137.png
L) PEsiiooicS

Home  Data | Desion

Bl | A m 5

Show Caption | EditNames || Auto Arrange | Arangen  Arrange
Columns  inRows

Count

Common Content Arrangement




image138.png
L] P
Home  Data | Deson

Dashboard Designer

‘mw‘ EdtNames | Auto Arange

Common

w3
A
o

‘Content Arrangement

E 89

DataLabels Tooltis. ‘mm
- ~ |captions.

oetLebds

Labels

Style

Colors | Colors.

Coloring

Data Source:
Adventureorks. -

1928z &

DATA TTEMS.

£ Date.Calendar
£ Date.Calendar ..
» B Fcal
€8 Date
E8 Day Neme:
5 Day of tonth
8 Day of Week
£8 Day of Year
5 vonth of Year
+ I, DelveryDate
» I Department
+ 1, Destiaton Currency
» 12 Employee
» 12 Geography
L+ 160 toternet Sl Ordec ... 7

Naw6opn 1

[Component|
st 1252%

‘Clothing:
800 %

11627%

mponents

[Component|
1950 %

“Clothing:
1821%

mponent]
683 %

Clothing:
2008 %





image139.png
] Heauis

e o |

A=k
Show Caption

EditNames.

Common

Content Arrangement

Coloring

Data Source:
Adventureorks.

1928z &

DATA TTEMS.

@ Adventure iorks
+ ulll Measures
+ L Account
+ L Customer

- & oate

Components:
282%

Components:

oty am Flesss

CY 2006

[Accessories: 42.16%)

Components:
1627 %

Components:





image140.png
Sales

e

[Rccessories 18.22%]

Data Labels

Deta Labels

Clothing - 15.53 %]

[Components : 52.70 %]




image8.png




image141.png
[ B

"

A

Show Caption | EditNames | Auto Arrange  Arangen | Arange
Columns | inRows.

Content Arrangement.

Dashboard Designer

E‘éi

Tooltps mm Data Labels:

Labe

Captons | Position ~

Fie

\ IE
EE!
Donut
foe]
Style

Local Edit Colors
Colors

Coloring




image142.png
None
Argument

Value

Argument And Value

Percent

Value And Percent

Argument And Percent
Argument, Value And Percent





image143.png
BE ™8T 4

DataLabels Tooltps | ShowPie | Data Labels
- ~ |captions | Positon ~

None
Argument

v Value
Argument And Value
Percent
Value And Percent
Argument And Percent
Argument, Value And Percent





image144.png
@

mu Shon Pie mnmds e |
e
—
Argument
Value
Argument And Value
v Percent
Value And Percent
Argument And Percent

Argument, Value And Percent





image145.png
CY 2005 CY 2006 CY 2007

CY 2008





image146.png
E %

ea b o) S

Labels





image147.png
e

Donut

Style




image148.png
Dashboard Designer

(6 images ~
8] TextBox
Swe | Unds Redo | Pwor  Gnd .
&R s
Fe History





image149.png
DATA ITEMS

|| et s Ama

| e sl et
s
e
o
_—




image150.png
30m o 30m o 30m o 30m o

20m SM - 20M SM - 20M SM - 20M soM

10m soM 1M soM 1M soM 1M oM

o om on om ou om ou om
Accessories Bikes Clothing Components




image9.png
5}

Dupicate

& [% Transpose

] Edit Rules.
Remove
ataltems 45 ConvertTo ~





image151.png
30M 40M

Target
20M 50M
10M 60M
Delta Indicator.
Delta Value - Actual

oM 70M




image152.png
Internet Sales Amo...

Reseler Sales Amo...

!




image153.png
Gauge Options

Scale Optons
Miimum value

Maximum value

Dela Optons
Value type:

Resultindication:
Threshold type:
Threshold value:

0

50000000

Absalite variaton
Greater s good

Percent

vy
vy





image154.png
Gauge Options

Scale Optons
Miimum value

Maximum value

Dela Optons
Value type:

Resultindication:
Threshold type:
Threshold value:

0

50000000

[ o





image155.png
e om e om e om e om

m s 2 s 2 s 2 son

W\ afassn  Jo O\ veszagos  fon o\ v foge,  fer o o

on Jon on Ton on Ton o Ton
Accessories Bikes Clothing Components




image156.png
Gauge Options

Scale Optons.
Minimum value

Maxinum value

Dela Optons
Value type:
Resultindication:

Threshold type:
Threshold value:

0,000,000, &

Percent variation
Greater s good

Percent

Cauto

Cancel





image157.png
Home.

| |

Data

=3 0015

Design

Al | =

Show Caption | EditNames

Auto Arrange | Arrangen  Arrange
Columns  inRows

Content Arangement.

Dashboard Designer

FullCraar | Half-Craulr Left-Quarter Right-Quarter ThieeFourth  Linear  Linear
Craar Craar Craler  Horizontal Vertical

Show Gauge
Captons

Labe




image158.png
f

i®
{@

Treemap

¥

CR

Fiter  Images TextBox Group

ements v v





image159.png
DATATTEMS

Cards

Sparkdne.

cards 1

$25.1M

Mountain Bikes
Bikes

-5.36 %

-1.42M

$11.7M

Touring Bikes
Bikes

+11.84 %

+1.24M

$30.5M
Road Bikes

Bikes
+3.99 %

+1.17M

$115K
Bib-Shorts

Clothing
-30.74 %

-51.3K





image160.png
Actual Value
S s305M A<= Delta Indicator

e Road Bikes

Subtitle
> Bikes

+3.99 % = Percent Variation
+1.17M <= bsolute Variation




image10.png
[% Transpose
] Edit Rules.

Ipota Ttems | 55 ConvertTo~

3 X

Dupicate Delete





image161.png




image162.png
Reseler TotalProduct Cost

Reseler Sales Amount




image163.png
Card Settings (E3)
e
e [ :

Threshold type: | Percent

o«

Threshold value: 0

o [t ) oo





image164.png
$25.1M v | | $305m a

Mountain Bikes Road Bikes

Bikes Bikes

-5.36 % +3.99 %

-1.42M +1.17M




image165.png
$25.1M v | | $305m a

Mountain Bikes Road Bikes

Bikes Bikes

-5.36 % +3.99 %

-1.42M +1.17M




image166.png
$25.1M $30.5M .

Mountain Bikes Road Bikes

Bikes Bikes

5.36 % +3.99 %

-1.42M +1.17M




image167.png
§25.1M $30.5M

Mountain Bikes Road Bikes

Bikes Bikes

-5.36 % +3.99 %

-1.42M +1.17M




image168.png
Mountain Bikes Road Bikes

Bikes Bikes





image169.png
e[ meo





image11.png
[% Transpose:
£ et rules
% comvertTo

[ Grd

Treemap
Range iter
Fier Eement
Bound mage
TextBox

[ER G RER ]





image170.png




image171.png
Delta Options | Sparkine Optons | Format Options

Vit 0 =
Ve i 0 Mao
Visble: Value Element
Lightweiht 7 T S
o e
M sobtite
W Percent Variation
M Absolute variation
M DeltaIndicator
M sparkine
[ Apply to Al cards

Apply





image172.png
$30.5M A
Road Bikes

Bikes
+3.99 %

+1.17M
g S e e N




image173.png
Road Bikes

Bikes

$30.5M &

+1.17M / +3.9 %

P SN e




image174.png
Road Bikes
Bikes

$30.5M A

+L17M [ +3.99 %

NN




image175.png
$30.5M

Road Bikes
Bikes




image176.png
Card Settings

LavoutOptons | Deta Optns | sparine Opters | FarmatOptors

select template:
Stretched
Centered
Compact
Lightweicht

Min width:
Max widh;

0| Mauo

EEEEE{E{EE

" Actual Value: -

Tite
Subtite

Percent Variation
Absolute Variation
Delta Indicator

3 Cancel Apply





image12.png
x & [% Transpose

B EditRules.
Dupicate | Delete  Remove
Data Items %5 ConvertTo




image177.png
Card Settings

=

[ Lovout ptons | el ptons | sparine OptarsEomatOatne 1)

Select value type:
‘Actual value
Target value
Absolute variation
Percent of target
Percent variation

Fomattpe: oy
= o -
e s -
e e
W Include group separator

$1.238

($1.23B)





image178.png
(B %

Show Caption | EditNames

Auto Arrange | Arrangen  Arrange
Columns  inRows

Count

Common Content Arrangement




image179.png
EI s - B B ll & @ @

Pvot  Gid Chart Scatter Pes Gauges Cards [Treemapl
“Chart

A Redo v

Fie History Insert





image180.png
Bikes Components

Ciothing|





image181.png
Biles - Road Bikes Bikes - Touring Bikes,

Components - Mountain
Frames

Bikes - Mountain Bikes

Components - Road Frames,

Compon...
= Touring,
Frames





image182.png




image183.png
Road Bikes|

Touring Bikes

Mountain Bikes’

th il

Components

Mountain
Frames

Road Frames

Touring
Frames

Wh.

Sert

Sh.





image184.png
X

Show Caption | EditNames Squarfied | Stiped _Layout
Directon ™

mon Lavout





image13.png
ETJ X Q zwmmlm

- Transpose:
Dot Dekte Come
] Edit Rules.

Ttem




image185.png
Bottom Left - Top Right
Bottom Right - Top Left
Top Left - Bottom Right
Top Right - Bottom Left





image186.png
‘Treemap Tools

Bl X
b Swtid Sroed Lot
o

Common Layout Tielsbes | Grouplabels Coloring





image187.png
Global labels

United States

‘Accessories ‘Accessories

Tile labels

Tile tooltip





image188.png
PATTEON

Value

Argument and Value




image189.png




image190.png
0 wsteox
T Treevew




image191.png
v 2005
v 2006
cv 007
v 2008





image192.png
=R 2R B

Show Caption | EditNames | Standard | Checked || show Al | Enable
Vaie | Search

mon Item Type Item Settngs




image193.png




image194.png




image14.png
8
[ vone [0

M -
=

Fie | tistory

= B

Dashboard

Data Source:

Adventureorks.

1928z =





image195.png
HIDDEN DATA ITEMS





image196.png
0013

G i
= e
=REA EIEEES

Show Caption | EditNames [ Checked | Radio | Show'al Enable
Valie  Search

Common Tem Ty

Item Settings.




image197.png




image198.png




image199.png
&

Home  Data | Desin

8| &

Show Caption | EditNames

70012

&

Cheded | Rado.

Common Item Type.

Ttem Settings.




image200.png
i





image201.png
£ 0015}

Home  Data | Desin

Olw e | S
o €t | i | e |

Common T lter





image202.png
£9001c!

Home  Data | Desin

=R

Show Caption | EditNames | AutoExpand |  Enable

Common Layout




image203.png
DATA ITEMS

—
— ==
I N P
[0 sweemon || Acesores
[+  produt | « V! BkERacks
! Froduct ) titchRack -+ 868
Dimension « W Cleaners.
7 Mo Diaver
Ve
'HIDDEN DATA ITEMS ¥ Mountain fikés
e V] Rosd ikes
U o
Dimension + W Cothing
+ M sods
Measures. W Mountain @iké Socks, L

W Mountain Bié Socks, M

Measure.





image204.png




image15.png




image205.png
August 2016 - November 2017 fus]

November 2017





image206.png
EditFiter

Filtering

% | %

Cross-Data-Source | Ignore Master
Fiterng Fiters.

Tnteractivit

tings




image207.png
Home
¥ A 2
Edtriter Cross Data-Source [ tgnore aster

Fiterng Fiters.
Fitering Interactivity setings




image208.png




image209.png
DATA ITEMS.

Show Caption
Duplcate

Delete

ComvenTo
Remove Data hems
Edit Names

it Fiter

Clear

R @ Update

it Perods
HIDDENDATA IS voime X
Custom Perod..
Cles MaserFiter
fe— in Preview
Export ToPDF

Export To Image.
Export To Excel

Export Dashboard

Q Q





image210.png




image211.png




image212.png




image213.png
Edit Periods =

Fiter by [Al -

Lostvear Capton Perod Oefault
Lost2vears

Lot 3 Years Last s Years 214-m18 o
oot vers

Thevear

Next Year

Lost Quarter

This Quarter \
Next Quarter

Lestorth

Lost 3 Manths

Lost Manths

Lost 2Months

Thsonth

Next Month





image214.png
B o= |[2][¥]
Capton Period
LastSYears 142018





image16.png




image215.png
O Previous Year

© This Year

O NextYear

Otast [ 1 -|years
ONext [ 1 -|years

Inciude current

2019





image216.png
O vear Startpoint @ None ) Fixed O Flow

©fuston Endpoint @ None O Fned O Fow

Entire Range





image217.png
Start point () None @ Fixed () Fiow

Sanuary 2019

Endpoit Oore Oroed @Fic]

Interval: [Year

January 2019 - December 2019

o





image218.png
Start point () None @ Fixed () Fiow

Sanuary 2019

Endpoint  ONene () Fixed © Flow

Interval: Month

January 2019 - June 2019

o





image219.png
%Eiiii\ﬂé@ =

Puot  Gid  Chart Swtter Pes Gauges Cards Treemap Range
“Chart Fiter  Eements ~

Tnsert




image220.png
(i

[ Accessores [ Bikes [ Clothing [ Componerts

€
El
3
£
<
8
©
3
B
K
g
4





image221.png
Dimensions

T Country.
t Category
Dimension
HIDDEN DATA ITEMS
Dimensions.
Dimension

Tree View 1
[41c0)
« W Australia
W Accessories
W sikes
W/ Clothing
¥ components
» M Canada
» M France
» ¥ Germany
» ¥ Unitedkingdom




image222.png
Scupi

(i

[ Accessores [ Bikes [ Clothing [ Componerts

Reseller Sales Amount
2 28 2 222 %2





image223.png
Interactivity




image224.png
DATA TTEMS
Values (Pane 1)

I ResellerSalesAmount

—_—

E 3 B

 S3jes JB|[asey

saddles
Components

Mountain Frames
Components

Forls
Components

chains
Components

ests
Clothing

Shorts
Clothing

Caps
Clothing

Road Bikes
Bikes

Pumps
Aecessories

Helmets
Aecessories

Bike Racks
Aecessories





image17.png
Grand Total

Resellr Sales A... | Reseler GrossP...

S5
23K
sL3m
sa2.5K

s1aa
B

siLeM

229
sa6M

s3.56M

87K

(5103
EXs
($1320
s
S
sz
sa0.6K
129
s
s1s6K
(37.3)
155K
($1360
s15.5
$66.5€




image225.png
I Accessores [ Bikes [ Clothing [ Componerts

sad
Components

Mountain Frames
Components

Forls
Components

ch
Components

vests
Clothing

Shorts
Clothing

Caps
Clothing

cessories





image226.png
Dimensions.

Combo Box 1
(@





image227.png




image228.png
EditFiter Cross Data-Source
Fiterng

Fitering Interactivity SCTNGS





image229.png
i

[ii]

Chart2

Combo Box 1

I Accessores [ Bikes [ Clothing [ Componerts

he
Components

Forls
Components
chal

Jersers
Clothing

Touring Bikes
Bikes

Tires and Tubes
Accessories

Hydration Packs

Bike Racks
! hccessories

EREEERE

JNoWY SB[ES B[Sy

] Hesdsets

ListBox 1




image230.png
Data Source Group fii]
[adventreWorks <
18218 =
+ . Geography - Combo Box 1 Chart2 th il
+ 18] Itermet Sl Oner De.. o -
+ | organizaton
- 1, ot ListBox 1 B8
» B3 Financl o @n -
+ B3 History W Bib-shorts U
» (3 stockng
B8 category. ] Bottom Brackets.
B8 Large Photo. M Brakes
8 ModelName
8 product
£8 productLine:
B8 styie
B8 subcategory.
b Product Categories th il
& Product Model Lines:
+ 1€ Promaton
+ 1 Reseler
+ 1] Resellr Saes Order Det...
+ 1€ Soles Chamnel
+ 1€ SlesReason
+ 1] Ssles Summary Orcer ..
+ 1€ Sles Terrtory
+ 1€ Scenario
» 12, shipDate.
L_» & source Curreney 7

Group2 fii]

I Accessores [ Bikes [ Clothing [ Componerts

Reseller ...
ERR

o
swauoduon
04
wos

sayossamy
Spey g

swauoduon

item has no data items

[ Accessores [ Bikes [ Clothing [ Componerts

<
8
=
&
)
3

g
&





image231.png
Combo Box 1 hart2 52
Clthing I Coting
ListBox1 R

M <

W/ Bi-Shorts 9 0c

] caps. 3

W Gloves P

il B

W shorts i

W] sods < ok

W Tihts BibShots Caps  Gloves Jeseys Shots  Socks  Tights  Vests

W vests Clothing Clothing  Clothing Clothing Clothing Clothing  Clothing _ Clothing

<
8
=
&
)
K
g
-4





image232.png
%Eiiiiﬁé@- -®?|mm

Puot  Gid  Chart Swtter Pes Gauges Cards Treemap Range _Fier
Chart Fiter Eements v i Group.

TInsert





image233.png
Emeges~ | [T

| @ Image
@ ot e





image234.png
Group2

Chart2

I Accessories [ sikes [ Clothing [l Companerts

whe
Components

sax
Components

pedals
Components

Headsets
Components

Forls
Components

Cranksets
Components

Brakes
Components

vests
Clothing

Socks
Clothing

Jersers
Clothing

Caps
Clothing

Touring Bikes
Bikes

Mountain Bikes
Bikes

Pumps
Accessories

Hydration Packs
hccessories

Bike Racks
Accessories

EREEERE

Junowy sa|es J|[@say

Combo Box 1

[

List Box 1

A
RETITTI

B 5 & & & 6 5 G S

[0 Accessarie [ Bikes [ Clothing [ Companerts

Chart 1

& F &
Junowy sejes Ja|[esay





image18.png
GrandTotal
Rescler Sales A, Reseler Gross ..

- Austraia Accessories | I EX3
Bhes sua (51320

Clthing sz 7.

Components s0% s

Ausiraia Total stson (51030
- Canada Accessories stisc 0.6
Bhes siLen (5120

Clthing $37 $sa.x

Components 220 s198c

ConadaTotal 130 i
- France Accessories £ sisis
Bikes $3.56M (51360

Clthing s123 s

Components s 6.5

France Total $4.61M ($37.39




image235.png
Home | Desin

‘D“‘/@

Show Caption | EditNames

fon

Common Open




image236.png
Group2

Chart2

Combo Box 1

I Accessories [ sikes [ Clothing [l Companerts

heels
Components

Saddles
Components

pedals
Components

Headsets
Components

Forls
Components

Cranksets
Components

Brakes
Components

vests
Clothing

Socks
Clothing

Caps
Clothing

Touring Bikes
Bikes

Mountain Bikes
Bikes

Pumps
Accessories

Bike Racks
Accessories

ERERERE

JNoWY SB[ES B[Sy

£
g
3
]
£
]
f]
1]
£
§
<
]

JNoWY SB[ES B[Sy

H

si1t

==

> ¥ Germany

> [¥] Urited Kingdom
> [¥] United States

List Box 1

A
RETITTI

B 5 & & & 6 5 G S

Group 1

R TreeView1

Image 1

Business Analysis Tool

Enterprise





image237.png




image238.png




image239.png




image240.png




image241.png
Image Binding Options.

© Binary Array]
Oure

URIPattern:

Insert Placeholder

Apply





image242.png
Image Binding Options.

O Binary Aray
©urt

URIPatter:

htip:/adventure:8510/country/{0}.png
| InsertPlaceholder |

Aeply





image243.png
1 Country. v

Reseller SalesA... | 3

Reseler Order ... | e
Reseler Freight .. | 3.
| Newcowm | [A]
Sparkine
HIDDEN DATA ITEMS





image244.png
1= | country
home  shore view
« « 4[] > ThisPC > Local Disk(C) > inetpub > bat > country
”~ Name Date modified
> s Quickaccess
[ Australia 11.02.20199:50
v [ ThisPC & Canada 11.02.2019 9:50
> [ Desktop 1 France 11022019 9:50
s [ Documents @ Germany 11.02.20198:51
+ 3 bowni 15 United Kingdom 1022019851
N [ United States. 11.02.20199:51
5 b Music
> [&=] Pictures
© B Videnc v
Stems

v|®) | search country

Type
PNG image
PNG image
PNG image
PNG image
PNG image
PNG image

Size

38
2K8
%8
%8
2K8
38





image19.png
8 PVBLS 00} Dashboard Designer
Home Da

O 2E08 = 6 0 ©

Show Caption | EditNames | Inital | Totals Grand layout RowTotals ComnTotds Values Resetlayout
Sater | v Totskv v  Postonv Poston™ Posiion  Optons

Compact
R DATA TTEMS V Tabular

Common Il .





image245.png
Images Australia fus]

Noimage data

Sales by Country th il
Country. Reseller Sales Amount Resellr Order Count Resellr Freight Cost
Australa SLEM A v $39.5€

Cansda L s e s
Fane e - s
O s
Untedngdon 82 e — s

United States: SN A A sL3M




image246.png
Image Binding Options
O ary Amay. The path to the folder
o containing the required

URI Patter: | C:\netpubpatcountry

-





image247.png




image248.png
Bound Image 1

Sales by Country.

Country Reseler Sales Amount Reseler Order Count. | Reseler Freght Cost
Australa v Xy
Canada - 359K
France - st
Germany. v e
United Kingdom - stom
United States - EE





image249.png
EE @@ IR V=

Puot  Gid  Chart Swtter Pes Gauges Cards Treemap Range _Fier
Chart Fiter  Eements ~ ﬁﬁmv

Tnsert




image250.png
Text Box 1




image251.png




image252.png
& Remove Dats kems
Ay Edit Names

P cditfiter

% Clesr

@ Update

Insert F‘Ba





image253.png
4 001

Data  Desin

Paste Specal

OXEdToT)

Fle | rome | Insert  Pagelayout Design

Calbri Ju A W

B I UUSSX X, Avy~

Dashboard Designer

‘ AzBbCcD
fiNormal  Hyperlink





image254.png
12084 @ 8

5 Month runber

Text Box 1

e




image20.png
L] oL oole) Dashboard Designer
Home  Data | Deson

Bly 08 @ & O

Show Caption | EditNames | Inital | Totals Grand layout RowTotsls ComnTotdls Values Resetlayout
sm:v‘ v Totssv v Poston” Posonv Posiion  Optons ‘

Inital .

Common Layout




image255.png
Home  Data | Desin

= v [A

Show Caption | EditNames | Edit

XBOXA 00





image256.png




image257.png




image258.png




image259.png




image260.png
8 IS LEOXS 001

Home  Data | Desin

Show Caption | EditNames.

Data Source:
5QL Data Source

Query

Saes

19218z & 5

- @ sdes
- S onoste

Vonth
P——

O % AR

Edt  Insert
Fied

Edthg

DATA TTEMS.

Values

Product (Min)

[ Unitprice (sum)

Desaripton (Min)

Valve.

Text Box 1
Name:AWC Logo Cap

Price:$3.418
Description:All-occasion value bike with our basic comfort and

safety features. Offers wider, more stable tires for a ride around
town or weekend trip.





image261.png
O Mountain-100 Black, 38
O Mountain-100 Black, 42
O Mountain-100 Black, 44
O Mountain-100 Black, 46
O Mountain-100 Siver, 38
O Mountain-100 Siver, 42
©) Mountain-100 Siver, 44
O Mountain-100 Siver, 48
O Mountain-200 Black, 38
O Mountain-200 Black, 42
O Mountain-200 Black, 46
O Mountain-200 Siver, 38
O Mountain-200 Siver, 42
O Mountain-200 Siver, 46
O Mountain-400-W Siver, 38
O Mountain-400-W Siver, 40
O Mountain-400-W Siver, 42
O Mountain-400-W Siver, 46
O Mountain-500 Black, 40
O Mountain-500 Black, 42

thil
Name:Mountain-100 Sitver, 44

Price:$17.3M

Description:Top-of-the-line competition mountain bike.
Performance-enhancing options include the innovative HL
Frame, super-smooth front suspension, and traction for all
terrain.




image262.png
Product

© Mountain-100 Black, 38
© Mountain-100 Black, 42
Mountain-100 Biack, 44
Mountain-100 Biack, 46
Mountain-100 Siver, 38
© Mountain-100 Siver, 42
© Mountain-100 Siver, 44

© Mountain-100 siver, 48
© Mountain-200 Black, 38
O Mountain-200 Black, 42
© Mountain-200 Black, 46
© Mountain-200 siver, 38
© Mountain-200 siver, 42
© Mountain-200 Siver, 46
Mountain-400-4 Siver, 38
Mountain-400-4 Siver, 40
Mountain-400-4 Siver, 42
© Mountain-400- Siver, 46
© Mountain-500 Black, 40

© Mountain-500 Black, 42
©) Mountain-500 Black, 44

Name:Mountain-100 Silver, 42
Price:$14.5M
Description:Top-of-the-line competition mountain bike.
performance-enhancing options include the innovative
HL Frame, super-smooth front suspension, and traction
forallterrain.





image263.png
St mont ()5
Format..
CrossPoft | Add FormatRule |
L it Rules.
- % EdRl
B ClearRules
L Rename...
segment
HIDDENDATA TENS
e
[
e





image264.png
Add Format Rule ¥

&

B Edit Rules
B ClearRules
Add Total ,
% ClearTotsls
oK
st6.6C
s
s
s
0.5

a8
a
4
L]
=
£
L4
B

Bar Gradient Ranges.

5%





image21.png
L] oL oole)
Home  pa

Ol 2 E08 2

Show Caption | EditNames | Intel | Totals Grand Layout RowTotals

Sater | v Totssv v Poston~
Common Expand Column Groups L
e v EpandRowGroups N\

Tdventiretiorks.

Values




image265.png
FTte 1898

Value N

Top/Bottom
Aversge
Eapresson
Icon Ranges
ColorRanges
Gradient Ranges >
Bar

Bar ColorRanges  +
Bar Gradient Ranges

@
[
=}
[}

Greater Than
Grester Than OrEqual To
Less Than

Less Than Or Equal To
Equal To

Not Equal To

Between

Not Between

Between OrEqual To

Not Between Or Equal To
Tect that Contains





image266.png
HIDDEN DATA ITEMS





image267.png
Values
[ e ]
Europe North America pacic
Format...
Gross Profit Sales Amount Gross Profit Sales Amount Gross Profit Sales Amount Gross Profit
V/ Show Values al $328K $169K STBIK. $365K. $163 $95.8€.
/ Show Totals 8.3 BK s1ax 746K 376K 2.5
Columns / Show Grand Totals $91.5 $48.5€ s21 $10 B 7.
e—— Add Rule I 403K 223 $96.3K $38K $216K.
er Format ,
T SalesTerritory Group. Value T e o ax
Column B it Rules Top/Bottom Grester Than Or Bt To som so.m B
B ClearRules Average Less Than sLzm s266M S99
Rove. Rename... [ Eression Less Than Or Equal To so13¢ s28M siom
Equal T 969K $2.08M $595
+ Category - & IconRanges qual To o o
1 Caender Quartr of Year - Clothing Total | 8 Color Ranges ’ Not Equal To s stx 7.5
o crat o GradientRanges | [0 Between 56,1 20 7466
C102] & Bar [ NotBetween K 0. 7.4
o 3 7 o5
« B BarColorRanges  » | [ Between OrEqual To §77. . bl
HIDDEN DATA ITEMS cros m.x s 6.9
- ComponentsTq B Bar Gredient Ranges » | (1) Not Between Or Equal To T2 e e
crar 233 Ted that Contains s 245 5185
Dimension
Measures





image268.png
Greater Than x

Format Sales Amount values that are greater than

[kenter a value>

Intersecton mode:
(Auto) -

Row dmension Column dimension
Terand Total Terand Total

Apply to
Sales Amount -

[ Apply to rom 1 Apply to column

o) (e ][ sesiv





image269.png
Greater Than ES

Format Sales Amount values that are greater than

1000000
Aspearance | lcons
T7ASUILASNY
—vavi!X QA
o NEEEOOO

L JCACKOR @ (34
all . &

Inersecton mode

Frstievel e

Row dmension Column dmension
[Grond ol [Grond ol

Aoty o
Sales Amount ]

[ Apply to rom 1 Apply to column

\mﬂmuwy\





image270.png




image271.png
sdesamaunt
— Format.

V' Show Values
V' Show Totals

Cotumns /' Show Grand Totals

1 SlesTeritoryGroup | AddFormatRule  »

| ul |
£ et
&) Clear Rules

Rename...





image272.png
Fiter by: [Soles Amount ]
Capton ClaiatedBy AopiesTo
¥ Greater Than (>1000000) Sales Amount Sales Amount





image273.png
T T i T
Caption Calculated By Applies To
W Greater Than (>1000000) Sales Amount. Sales Amount





image274.png
Edit Rules

Edt

|[ et |[[W

Fiterby: [Sales Amount

Greater Than (>1000000)

Calaiated By
Sales Amount

Apples To
Sales Amount

Add

| colated by [sales Amount





image22.png
- Australa Total

Clothing
Components.
~ CanadaTotal

~ United States Total
Accessories
Bikes
Clothing
Components.
Grand Total

Grand Total

Resellr Sales A... | Reseler GrossP...

S5
23K
s13m
sa2.5K

s20%
s1aa

s
siLeM

229
sa6mM

s3.56M

s

87
sLoaM
351K
sus
716K

sa28M
sa2.6K
s34
stis
71
ss3.6M

saaam
sLow
.4
ss0.sM

(s109)
EXs
($1320
s
EERs
s
sa0.6K
(51120
s
stsec
©37.30
st5.5K
($1360
15,5
$66.5K
(s1119
$12.1K
($1360
(s82)
$13.%

4.5
@m0
BErs
$57.%
$543
104
(398K
stsi

sa7c




image275.png
Value >
Top/Bottom »
Average »

Expression
Icon Ranges »
Color Ranges »

GradientRanges >
Bar

Bar ColorRanges
Bar Gradient Ranges »

FTte 1898





image276.png
Intersecton mode:
Lastlevel -

Row dmension Column dimension
Terand Total Terand Total

Apply to
Calender Guarter of Year I

Apply torow Apply to column

[ [t |[Coomiy |





image277.png
Europe North America Paciic
Soes Amount | GrossProfit | Saes Amount | GrossProfit | Sales Amount__| Gross Profit
~ Accessories Total =3 stoax B3 E=3 163 s
crat ss8. 8K s1ax 75 s37.5K E=3
o £ s sa1x st a6 27.%
e 5.k o s ER s7.5 sk
cros w2k a6 sox e s 221
v BikesTotal [] $17.2M s3.16M @ $67.3M s39m & $10.2M $3.44M
orar sa.9u £ si5.a sz 266 ssax
o sa7a stosw s E EXt sLom
o sa12u s0x s 4 2.0 ssosc
oo s34 sisc s7m s 255 s
v Clothing Total $90K. sse.x @ By 284 $113 7.5
orau o 1% siLec $260K. 856K $7.4
o s100¢ sts.5 a1 7 0. EXT
de @ st st s o oK s
o @ st stask sox 2 s 5%
< ComponenisTotal | @ som s @ s s e s
crau o s235 s18¢ s1oam S10K. s18K
o e s 2.4 s2x B EXS
ores 7oK s S8 s sk a6
cras 20K 2K 2. £ sax EEE




image278.png
Toph [E3]

Format Sales Amount values that rank i the top

90

Intersecton mode:
(Auto) -
Row dmension Column dimension
Terand Total Terand Total
Apply to
Category I
Apply torow Apply to column

\m‘\muwy\





image279.png
Europe.
Sales Amount__| Gross Profit
+ Accessories Total s stex
cra ss8. $8.K
cr@ L 0.
cras £ sk
cros w2% sa26c
v BkesTotal | @ s7.M s3.16M
cra B ssoac
cre sa7a stosm
cras st s0x
cras B ssisc
+ othing Total s $56.5
crat o 1% st
cre sto0K s15.5
cras o sz sS4
cros o st0x s
+ Components ... Jr| @ s s138€
crat [ ] $235K $15
cr@ B 3K
cras 7ok $53.K

cves saa0c 21K

North America

Sales Amount
SmIK
s143
213
s
s20

(] 7.3

sis.a
s
s16.M
sm

(] sieM

sa1x

s

(] so.68M

sLom
24

EXY

Gross Profit
36K

Pacic
Sales Amount

163

s37.5

sac

7.5

BrEs

@ som

266
28M
208
25M

sux
243
0.
305
27.%

s20%
245
$54.1K
B3
saLx

Gross Profit
958K

EEY

27.%

21

75K

S
518K

EXS
BX3
3%




image280.png
Value >

Top/Bottom »

Average »

Hbove Avrsge
bpreson

Above Or Equal to Average
Below Average
Below Or Equal to Average

Icon Ranges »
Color Ranges »

GradientRanges >
Bar

Bar ColorRanges
Bar Gradient Ranges »

FTte 1898





image281.png
Expression

Format values that match the following condition

Ad® O
- [sales Amount]

Equals |7 <enteravaes 0 @

= Eauals
= Doesnot eaual

> Isgreater than

> Isgreater than or equal o
< Iskess then

< Isless than or equal o
& Isbetneen

& Isnotbeteen

ERT]

® tsnotnul

@ 1sanyof

@ 15 none of

[sales Amount] = ?

Intersecton mode:
[ ]
Row dmension Column dimension

[loandTot] - [fand ol ~|

Apply to
Sales Amount -

[ Apply to rom 1 Apply to column





image282.png
FYe 189 B

GradientRanges >
Bar

Bar ColorRanges
Bar Gradient Ranges »

2Ranges
+1 31 00 Xv 09

3Ranges

491 394 v—2 000 QEE
CA® X ! v QO Yrirk Wi

aillullatlatl
5 Ranges

U AT JuD AL OCOIO
il





image283.png
SdesAmount | GuossProft | SoesAmount | GrossProft | SakesAmount | GrossProft
Format... s stoax s 23 stox 5.8
ss8. K st 73 s7.5K 2%
£ s sa1x st a6 27.%
£ Y s22x ER s7.5 sk
Show Grand Totals w2% sa26c s0% 6.4 sax 24K

Show Values
Show Totals

Add Format Rule  » | Value ) Baem @ $67.3M oM @ $10.M e
Edit Rules. Top/Bottom NES sisa s1am s268M s9ax
Clear Rul 5L0SM $17.5M $907%K $2.89M $1.0M
e Average > s si6.M sS4 208 ssasc
Rename... B bpression P e oo
~ ClotingTota | e Icon Ranges [,
cra1 q . Ranges
o § Clarkngs 0 | 4 p 34 @O Xv OO
@ Gaderttonges >
S 3 Ranges
o
oS OATA TS o AE L |391 494 v—2 @00 mEE
B o WE GnClorfngs b g A X 1y QOO Tk Wrw
cror Bu BarGradient Ranges »
‘Dimension orQ2 4 Ranges .
e s 337t 332t 0000 0000
aillalatlatl
e -
32t SuAt OCIIO
]





image284.png
Range Set

=

Format Grass Proft values using range conditons.

Fomatstye
YuAL M
/] Use % ranges.
- mo% > m0w
A mww 0.00%
o 50.00%  >=  2500%
¥ mw% = omw
Intersecton mode
) -
Row dmension Column dmension
[Grond ol Tarand Tota
Aoy to
Gross rofit -
[ Apply to row [ Apply to column

|| cancel || apply





image23.png
L] Huut i e

i oo
B o

By 2 Ea8 8
At A Ll LA .
e e

Data Source paTarre v Show Row Grand Totals





image285.png
fu 0000%  >=  75.00%
P T0%  »= S0.00%
Y smo% - :00%
3 500%  >-  000%
|| peete Reverse





image286.png
1+ wow s meow

-] mww >= soow
>

k] 50.00% > 25.00%

+ mww > 000%

dd 4K peete Reverse





image287.png
1+ mon >

A =
=

90





image288.png
Range Set x

Format Grass Proft values using range conditons.
Format style

Juat -

[ Use % ranges.
500,000.00
500,000.00 100,000.00
10000000 >= 500000

500000 >= 0.00

(" ada [ pekte |

Intersecton mode:
astievel I
Row dmension Column dimension

[Grand Tota] [Grand Tota]

Apply to

(Gross Profit -

[ Apply to rom 1 Apply to column

&

|| cancel || apply





image289.png
Pivot 1 th il

Europe. North America Pacfic
Sales Amount | Gross Profit Sales Amount | Gross Profit Sales Amount | Gross Profit
~ Accessories Total s stoxc £ E=3 st a5
crar EE $38.1€ $19% W BES 379K W 23
Q2 soLek W 8K sax A $10x saec M $27.%
cres a5 W $398K s M $95.7 s37.5¢ M s2Lx
cros X $a26K s M $96.K saLx W 24K
- bkesTowl k@ S s @ s com @  soom o
ooy EXI0E 3 sssaK s 4 sLm EX0E 3 943
cre2 sa7am 4 $105M sz 4 $90%K. s28m 4 s1om
cres, sa1m A $903 sie.m A S s208m A $595
cras sa3m 818K, sum 4 s128M 25 4 @7
~ Clothing Total $90K. sso.k @ sLEM 8% $113. 7.5
crQt [ ) 71X W $1L6K $260K W $56.1K 24K W $7.49
o s00¢ % s sux M 7K Er .5K
orQs [ ] $120k W $14.9€ 52K W 7K 0. W K
cres [ ] $10x W $14.9€ 0K W $72.5 s272.% W $6.5%
~ Components ... Y & 1.9 sk @ $9.68M 88 $20%. $13.7C
crat o ] s1sc stom A s oax § SLX
crQz saa6K W $33.9K. s2.4m $22% e 3 $3.6€
crQs sk W $53.5K 8 A $325 sk ¥ $4.86€
o4 440K W $32.1K. 2.4 7 $22%. sk § $3.35




image290.png
Value >

Top/Bottom
Average »
Expression

Icon Ranges »

CoorRangss b |
GradientRanges >
oar

BarColoranges >
o Grdient Ranges. >

[ ]





image291.png
Pivot 1

Europe North America Paciic
sdes pmount__| GrossProft___| saks Amount__| GrossProit | sees Amaunt__| Grossrrot || ReneSet =
~ Accessories Total =3 stoax B3 E=3 163 s
o s % ek e M ox e w s || T Ces e e ondies
o siscw sex amn e o || Femeie
o s ma wmow  ssw wxow e || [ X
oros sx % sas @mow sex sk w s
v BkesTodl 9| @ $17.2M 1M @ 7.3 s.9M @ s10.m $3.4M Use %ranges
ooy s30m 4 888K sisam 4 s12m s266M 4 sax (| [ - >=  800,000.00
o M 4 suosu s 4 ss0x com 4 s || 100,00000
o wmn e sew e mow o s
oo sam 4 s oM 4 suam s 4 s || | L] oo 5000.00
v Clothing Total $401K 6.k @ B 8% s1x 7.5 O 500000 >= 0.00
co @ eaw sk xS sex  ax N oe
o oo N msx s W ex  saow e
EEI ) socw wmax ewow ex o saowow
oo @ X M smx  woxw sex @M s | o | =
v Components ... | @ s1om s @ so.68M 882K a0 s (| =
ETa—) wx 8 am san sk b 00k || e
ooz s mw ew s e wxd e
s L3 = B = [ | e— P
G Lo o wx¥ 8| oo ] w7

Apply to





image292.png
[

Value ’
Top/Bottom ,
Average ,
Expresson

Icon Ranges ,
ColorRanges
GradientRanges >
Bar

Bar ColorRanges
Bar Gradient Ranges »

2 Color Gradient

amam
T

3 Color

[ i

fmmani

[ IMMRCLTTE





image293.png
Gradient Ranges x

Format Grass Proft values using range conditons.

Number ofrangess
| GenerateRanges |
/] Use % ranges.
B - wo% > %
0 s 0.00%
0 om0 n00%
0 o s0.00%
[T TS 5000%
0 s 000%
ST TS 000%
B n0% > mow
ST n00%
B wow 000%
Intersecton mode
[ ]

Row dmension Column dimension
Terand Total Terand Total

Apply to





image294.png
ENEENEENEEE

100.00%
0.00%
000%
m00%
0.00%
0.00%
w00%
000%
200%

10.00%

000%
000%
m00%
0.00%
0.00%
w00%
000%
200%
0.00%

0.00%





image24.png
L] e Tz Dashboard Designer
= e

O 2E08 = 6 0 ©

Show Caption | Edthames | Intal | Tos Grand layout RowTods CobmnTows Vabes  Resetleyout
sm:v‘ “° rotwsv o beston~ poston~  poston®  Optons

/ Show Column Totals Layout
|V ShowRowTotsls 1 |

Common Il .

Data Source





image295.png
PPé& 129

Value
Top/Bottom
Aversge
Eapresson

Icon Ranges
ColorRanges
Gradient Ranges
Bar

Bar Color Ranges
Bar Gradient Ranges





image296.png
Bar

=

Format Grass Proft values using bar conditions

0] TAutomate

0] [Automatic

Custom Appearance

Intersecton mode:
(Auto)

Row dmension
Terand Total

Apply to
Gross Profit
Apply torow

V] Alow negative axis.
[Clorawaxis
] show bar only.

Column dimension
Terand Total

Apply to column





image297.png




image298.png
V' Show Values oY 472
Columrs V' Show Totals Q. E
t Category.  ShowGrand Totals /@2 $.6%
o
e | Addromatrue » [ valoe > e
B Edit Rules. Top/Bottom » i
s B ClearRules Average >
B Calendr Year Rename.. B Bpression B
i
 Calendar Quarter of Year v} o @ IconRanges * e
Ron /@ ColorRanges > la

o GradientRanges  »

HIDDENDATA IS ER N |

B BarColorRanges  »

Eu BarGradient Ranges »

Dimension




image299.png
2

conditons.

Min=

Max =

)

0

0

Degative style Settings

Format Reseflr Gross Profit values using bar

Automatic -

Automatic -

Custom Appearance

Intersecton mode:

astievel

Ro
Terand Total

Apply to
Reseler Gross Profit

Apply torow

¥/ Alow negative axis
[ Draw axis
(] Show bar only

Column dimension

Terand Total

Apply to column





image300.png
Bar

2

Format Reseflr Gross Profit values using bar

conditons.

Min=

0] [Automatic
0] [Automatic

Custom Appearance

Intersecton mode:
Lastlevel

Row dmension
Terand Total

Apply to
Reseler Gross Profit
Apply torow

] Allow negative axis
] oraw axis
] show bar only.

Column dimension

Terand Total

Apply to column





image301.png
v 005

v o006

cvano7

cres
cras
crar
cre2
cres
cras
crar
cre2
cres
cras
crar
o2

Rt st FER




image302.png
B

Fte 189 E8

Value ’
Top/Bottom ,
Average ,
Expression

Icon Ranges ,
Color Ranges ,

GradientRanges >
Bar

Bar ColorRanges >
Bar Gradient Ranges »





image303.png
Color Range Bar x

Format Reseflr Gross Profit values using color
range bar conditons:

Format style

IR -

/] Use % ranges.

[~ mom% > 70%

0 s 5000%
[ so% > 0%
[ m0% > oo%

|

mode.
(auto)

Row dmension Column dmenson
[ferand Total ] [[Grand Total

Apply to
Reseler Gross Profit

Apply torow Apply to column





image304.png
O[] e

0 s

YUy

7500%
0.00%
200%
000%





image25.png
Australia Total

Canada Total

Grand Total

Resellr Sales A... | Reseler GrossP...

5]

SL3M
sa2.5K
s20%
sLsoM
B
siLeM

229
$14.4M

($1320
748
s
(51090

(51129
ss.x

17K




image305.png
=]
T www% - mww |
[m]

500%  >=  00%





image306.png
O  wow 0%
[ f s s000%
] =

No Style

Custom Appearance





image307.png
Fte I22808

Value ’
Top/Bottom ,
Average »
Expression

Icon Ranges ,
ColorRanges
GradientRanges >
Bar

Bar ColorRanges
Bar Gradient Ranges »

2 Color Gradient Ranges
EmEca
e o
[y N |
OO e
3 Color Gradient Ranges

[ [m—
[— 3
| ] - ]
[ | [ |





image308.png
Bar Gradient Ranges. (x|

Format Reseflr Gross Profit values using range bar
conditons.

Nmberofranges: [ B2
GenerateRanges |

/] Use % ranges.

B - woo% > soo%

B smo% > sww%

B oo% > w0%

B on% > mow

B »o% > oo%

Intersecton mode

(Auto) -

Row dmenson Colunn dimension

[Grand Total] [Grand Total]

Apply to.

ResclerGosproft  ~|

Aoslytorom Aoply to column

/1 Alow negative axis.

Corawaxs

) howbar only

| e (s





image309.png
EREEE

100.00%
000%
0.00%
w00%

000%

000%
0.00%
w00%
200%

0.00%





image310.png
Grid1
Subcategory

Bottes and Cages
Bottom Brackets.
Brakes.

Cops

Chains.
Cleaners
Cranksets.
Deraileurs.
Fenders

Forks

Goves.
Handiebars
Headsets
Helmets
Hycraton Packs:
Jerseys

Lodss

Mountain Bkes.
Mountain Frames
Pedals

Punps

Road Bikes:
Road Frames
Saddes

Shorts

Sodks.

Tights.

Tires and Tubes.
Touring Bices

Order Count





image311.png
tmmvzl‘

4 Sot Ascending
OrderCount | 2 ot Descending
No Sorting
Sortby »
Sparkine | TopN.. w
ey Add FormstRule »

New Column

Edit Rules.

Clear Rules.

LN ]

Rename.





image312.png
Top N Values (=3
ke
Wode: o -
Count st
— Onder Cout -

Aeply





image313.png
2





image26.png
Australia




image314.png
Grid1

Subcategory. Order Count

7.5%
6.1
5.2k
a7
EES




image315.png
[ ourcmt

New Column

Grid1
Category
Accessories
Accessories
Accessories
Accessories
Accessories
Accessories
Accessories
Bikes

Bikes

Bikes
Clothing
Clothing
Clothing
Clothing
Clothing
Clothing
Clothing
Components.
Components.
Components.
Components.
Components.
Components.
Components.

Subcategory
Tires and Tubes.
Helmets

Bottes and Cages
Fenders
Cleaners
Hycraton Packs:
Bike Racks.
Road Bikes:
Mountain Bkes.
Touring Bices:
Jerseys

Cops

Goves.

Shorts

Sodks.

Vests

Tights.

Road Frames
Handiebars
Mountain Frames
Pedals

Viheels
Saddes

Brakes.

Order Count





image316.png
Subcategory Order Count

Tires and Tubes.

|

Accessories Bottes and Cages
Accessories. Fenders




image317.png
Grid1
Category
Components.
Clothing
Components.
Components.
Components.
Accessories
Components.
Components.
Components.
Accessories
Clothing
Clothing
Accessories
Clothing
Accessories
Clothing
Bikes
Clothing
Clothing
Accessories
Bikes
Accessories
Bikes
Accessories

Subcategory
Brakes.

Tights.

Saddes
Viheels

Pedals

Bike Racks.
Mountain Frames
Handiebars
Road Frames
Hycraton Packs:
Vests

Sodks.

Cleaners
Shorts

Fenders

Goves.

Touring Bices:
Cops

Jerseys

Bottes and Cages
Mountain Bkes.
Helmets

Road Bikes
Tres and Tubes.

Order Count





image318.png
No Sorting
Sortby »

e TopN...
Add Format Rule >





image319.png
Subcategory
Road Frames

Mountain Frames

Order Count





image320.png
sm [=

=
3 Sort Ascending
STy | 42 Sont Descending
NoSor
e "
sotty .
o Top.
AddFormat e >
B Edit Rules
Argument | B Clear Rules.

Rename.





image321.png
A
2

z
Z

Sort Ascending
Sort Descending
No Sorting

Sortby v
T

Add Format Rue

it Rules.

Clear Rules.

(Valug)
(Display Text)
(Key)

®)

Rename...





image322.png
| @ Automatic Updates |
@ Update
[ parameters

Dashboard




image323.png
Category.

Stbeategory.

Order Count

x

Grid1

SalesAmount | v| 33
| For

Sparkdne.

New Column

=
[

Add Format Rule »

Edit Rules.

Clear Rules.

Rename.





image27.png
/ Show Values
e / Show Totals
T Coendarvear Show Grand Totas
@ AddFormstRule 3
B EditRules
Rows B ClearRules
t Country Rename...
t Category. ===
Accessores
Row Bikes.

saam
B

23m
266K
sL7M

($10%)

sLom
7.5

s13M
s16.3
sLam

S1LK.
(1159
755
243
(54959

2799

sL3M
M
sa2.5K
s20m




image324.png
Format type: .

Unit: Auto

Predision:

Currency: Use dashboard settngs
Culure: Use dashboard settngs

¥/ nclude group separator

$1.238
($1.23B)





image325.png
2

Format type:
nit
Preciion:
Currency:
Cultre:

Auto

Auto
General
Number

Currency
Scientifc
Percent

¥/ nclude group separator

$1.238
($1.23B)





image326.png
FulDate (Year) |~

z
Z

% sort Ascending

Sort Descending

TopN,

§§§§§i

Year
Quarter-Year
Day-Month-Vear
More

Bxact Date
Format (Default)
‘Add Format Rule
Edit Rules.

Clear Rules.

Rename...

V Defaut





image327.png
Show Values
Show Totss

Show Grand Totss
AddFormstRule ¥
it Rules.

Clear Rules.

Rename...





image328.png
Fomattype:  Curency -
it huto -
precsion
Currency: ER (o) T
- £GP Egyptan Pound) 5
ERN (Eritrean Nakfa)
ET6 (Ethopan Bir) 0
Wl ndude groun se ¢ g (eurc)
# (yen o)
FKP (Falkland Islands Pound)
GBP (British Pound) e
€1.23B
(€1.23B)





image329.png
Format type: Currency -

Unit: Auto -

Predision:

Currency: USD (Us Doller) -

Cultre: Cherokee (Cherokee) -
Englsh (Paleu) =

W/ inciude group sep| Englsh

(Puerto Rico)

Englsh (Turks and Caicos Islands)
ExER
Englsh (US Minor Outying f3nds)
Englsh (US Virgn slands)
Englsh (zimbabie)

(€1.23B)





image330.png
Format type:
Unit:
Predision:

Currency:

Currency
Auto

USD (US Dollar)

Cultre:

! ncude group sep)

Use dashboard setings.
AED (United Arab Emrates|
AFN (Afghan Afghan)
AFN (Afghan)

ALL (abbanian Lek)

AMD (Armenian Dram)

| ANG (Vetherlands Antilean Guider)

$1.238
($1.23B)





image331.png
Dashboard Currency Settings
(x]
::;':F 150 (US Doliar)
English (United States)
$123
($123)

|| caneel





image332.png
[% Transpose:

2B Tite |G Automatic Updates |
G Curency @ Lpcate
it Colors_ [ parameters

R shboard





image333.png




image28.png
=

RowTe
Position *

i)

Totals:
Postion ~

Top
v Bottom





image334.png
IT(W] e

General
visble.
Alow Nl
Alow Mutselect
Name.

Data
Desaripton
LookUp Settings.
Select All Values
Type
Value:





image335.png




image29.png
S B ¢
Fotim= e o

Gl Nesr
v Far





image336.png
Alow Mutselect
Name.

Data
Desaripton
LookUp Settings.
Select All Values

Type





image337.png
Alow Mutselect | No
Name.
Data ~
Desaripton
Look4p Settings  NoLook Up.
Select AllVaues | No

Type Number (64 bit inte...

Value: 1000000

[ (e ] [#] [0





image338.png
Expression ]

Format values that match the following condtion

Ad® O

.- [Reseler Sales Amount] Is betweenf<=nter 5 UalUe| ,* and <enter 3 vabue:
double click
« »

[Reseller Sales Amount] Between(?, ?)





image339.png
Expression =)

Format values that match the following condition

Ad® O .
.- [Reseler Sales Amount] Is between ?5ales{ @ Jand <enter 2 vabe> @

“ 5

[Reseller Sales Amount] Between(?Salest, ?) Apply to
Reseler Saes Amunt <]

! apply torow.





image340.png
Expression ]

Format values that match the following condition

m® O o
" Reseler Sales Amaunt] s between 5akes{ @ Jand <enter avalue> @

double click

‘ ,
[Reseller Sales Amount] Between(?Sales, ?)





image341.png
Expression

Format values that match the following condition

Ad® O ; .
.- [Reseler Sales Amount] Is between sales1 @ and7Saies2
Salest
| sale2 |

[Reseller Sales Amount] Between|

Apply to
Reseller Sales Amount

! apply torow.





image342.png
Expression ]

Format values that match the following condition

Ad® O
.- [Reseler Sales Amount] Is between Sales1 @ and 753les2 @ ©

[Reseller Sales Amount] Between(?Sales1, ?Sales2)

| ok || cancel || appy





image343.png




image344.png




image345.png




image30.png
Grand Total
- Australa Total
Australia

~ CanadaTotal

Grand Total

Resellr Sales A... | Reseler GrossP...

o

sLsaM
23K
s13m
sa2.5K

s1aa
s

siLeM

2.2

sa7c
(s109)
EXs
(51329
s
EERs
s
sa0.6K
(51120
s
$196K




image346.png
Grid1
Subcategory Reseler Sales Amount
Bib-Shorts

Bike Racks

Bottes and Cages

Bottom Erackets

Brakes

caps

Chains

Cleaners

Cranksets

Deraileurs

Forks

Goves

Mountain Bkes
Mountzin Frames
Pedals

Pumps

Road Bikes

Road Frames

Tires and Tubes

Touring Bices





image347.png
DATA TTEMS

Columns

Category

Subcategory

Order Count

New Column

Sparkine

Argument

HIDDEN DATA ITEMS

Dimensions.

Dimension

Measures.

Measure





image348.png
[ oo
| subcategory
[ owcam

New Column

Subcategory
Brakes.

Tights.

Saddes
Viheels

Pedals

Bike Racks.
Mountain Frames
Handiebars
Road Frames
Hycraton Packs:
Vests

Sodks.

Cleaners
Shorts

Fenders

Goves.

Touring Bices:
Cops

Jerseys

Bottes and Cages
Mountain Bkes.
Helmets

Road Bikes
Tires and Tubes.

Order Count.





image349.png
Category.

Subcategory.

Order Count

New Column

Subcategory
Tires and Tubes.
Helmets

Bottes and Cages
Fenders
Cleaners
Hycraton Packs:
Bike Racks.
Road Bikes:
Mountain Bkes.
Touring Bices:
Jerseys

Cops
Goves.
Shorts
Sodks.

Vests

Tights.

Road Frames

Handiebars
Mountain Frames
Pedals

Viheels

Saddes

Brakes.

Order Count





image350.png
Subcategory
Ties and Tube

®
2
2
=)
L4
|?
%

Show Caption
Duplicate

Delete

ComvertTo
Remove Dt hems
it Rules
ditNames
e\
Clear

Update

Maimize

Print Preview.
Export To POF
Export To Image
Export To Bxcel

Export Dashboard

Saddes
Brakes.





image351.png
54




image352.png




image353.png




image354.png




image355.png
Values.

Salesamount (sum) |~ | | Pivot 1

Vale
Category
Coumn
Rows
B =
[+ Quarter
Row
HIDDEN DATA TTEMS.
Omensions
Dmenson
Vesaures
Vessure

Count

Count Distinct
Sum

Min

Max

Average

More »
Calculation N » |
Format...

Show Values

Show Totals

Show Grand Totals
Add FormatRule >
Edit Rules...

Clear Rules.

Rename.

5= e
$544M

wnl Tesl a

$170M $1:

$430M $10.28 43¢

(None)

Percent of Column Grand Total
Percent of Row Grand Total
Percent of Grand Total

Running Summery along Columns
Running Summary along Rows.

Difference along Columns

Difference along Rows

Percentage Difference along Columns

Percentage Difference along Rows.

Rank along Columns.

Rank along Rows
Rank along Cells

Customn...




image31.png
Australia Total

Canada Total
Grand Total

Grand Total

SL3M
sa2.5K

sLsoM
B
siLeM

229
s1aa
S16m

Reseler Sl ... | Reselr GuosP..
[ )

($1320




image356.png
HIDDEN DATA ITEMS

ASRNEN

&a

v (None)
Percent of Column Grand Total

Percent of Row Grand Totsl
Percent of Grand Total

Running Summary along Columns
Running Summary slong Rows
Diference slong Colurns

Diference slong Rows

Percentsge Diffrence slong Columns
Percentsge Difference slong Rows
Rank slong Colurmns

Rank slong Rows

Rank slong Cels

Custom..





image357.png
Calajation Type:

Running Total
Moving Calaulation

Percent Of Total

The current measure has no calculation applied

Apply





image358.png
Calaiation Type:

Fuming ot
Movng Caafaion

Percent Of Total

RunningSum(Sum([SalesAmount]))

Aeply





image359.png
Running Total

SRCER

20410
25420410
25425420410
0425425420410




image360.png
Month

Sales.
e
s
s
su7m
s
$63.3M

Running Total of Sales.
e
s2om

sa10m
s




image361.png
Calaiation Type:

Running Total
Mioving Calcuaton

Percent Of Total

WindowSum(Sum([SalesAmount], -2, 0)

Aeply





image362.png
HEIE

EI

Startoffss
o0+10420

1; Endoffset

10420425
20425425
25425420
2542040




image363.png
Year Month |SalesAmount (Sum) | Moving of SalesAmount (Sum)

August sam e
Decenber 12 saom
sy s o
P November sm 3260
October sman o7

Septem... $63.3M &M




image364.png
Calaiation Type:

Running Total —_—
Vovng Calcdaton Difference from: | Previous -

[percent Of Total

Sun([Salesamount]) - Lookup(Sum([SalesAmount]), -1)





image32.png
g ,0

Valves. Layout
Postton ¥ Optons

V' Columns





image365.png
BH B8

alolals

2010
520
528
w2




image366.png
Year  Month  SalesAmount (Sum) | Difference of SalesAmount (Sum)

August e
December s s
15 MY s (ss8M)
Nove... su7m sisa
October s (s106M)
Septem. $63.3M (§7.49M)





image367.png
Calaiation Type:

Running Total
Moving Calaulation

Bercent OF ot

Percentof totalby: | Rows.

ToDouble(Sum([SalesAmount]))/ Total(Sum([SalesAmount]))





image368.png
Percent

SRCER

10.00 %
200%
2500%
2500%
2.00%

10/100%100%
20j100%100%
25}100100%
25}100100%
20j100%100%




image369.png
215

G

SalesAmount (Sum)  Percent of SalesAmount (Sum) T....

e
s
s
su7m
$70.8M

0.76%
12%
0.23%
161%
0.64%




image370.png
Caladaton Type:
Nore Rark deng: Rons

Rurring Totsl —]
o ton Rark type: Competion B
Ofference

percntof ot orders © ascendng

{Rark O bescendng

RankCompetton(Sum ([SalesAmount]), ‘2sc)





image371.png
Competiion k.

10202525
12244





image372.png
Year

215
215
217
w018

‘SalesAmount (Sum)

218
$5.088
$3.29%8

Rank of SalesAmount (Sum)




image33.png
Australia

Grand Total

Resellr Sales A... | Reseler GrossP...

5]

SL3M
sa2.5K

i
siLeM

229

EXs
($1320
s
S
sa0.6K
(51129
s
s1s6K




image373.png
Calaiation Type:

Running Total
Moving Calaulation

Percent Of Total

Calaistealong: |Rows.

Sun({Salesamount])

| edtnbpresonctr





image374.png
Sun[salesanount])

[ et

- @ sdes
- £ DinDate:





image375.png
Sales by Category Bikes fii}

Reseller by Country - Reseller Order Quantity . [1] #

1,56ThIC. v
Australia

-89,77%

-13,6TbIC.

. .

13,57eic. v
Canada

-11,28%

-1,727bIC.

Reseller Sales Amount by Category

I Soecilty Bikeshop [l Velue Added Reseler [l Warehouse

5 0um
<
)
T 20mm
8
5 10mn
3
]
. .
skes
‘Sales by Subcategory i o
bty | elr .| Reslr s .. el O
vorinsies R s o A
Rondies B maed e
racegsics [+ MG 10 A

th %
Reseller Sales Amount
Bikes: 66,30 § (62,41%)

[Bikes: B2.41%}—
‘Accasonest
071%
Components:
1467%





image376.png




image377.png
Home | Data | Desin

4 L ©
e





image378.png
Dashboard Title text Parameters

Dashboard Title images | ‘Mmur Filter state _Export To |
/sg/' T &

Sales

Sales by Category 13 e 27 | seles by subcategory i
Category | solshm... | Solshmant cTor...
tegory Ml sikeracks [ Bottles and Cages
sa0m +5.25% A Helmets
$i0.25 20.39% M I HydrationPads [ Mountain Bikes
2% W Bl RoodBikes [l Tres and Tubes

I Tourng ks

SalesAmount
§ 888 ¢

Bikes

2017:
457 %

P AYAVavE
cr 27
ol
January Apil July  October





image379.png
[ automatc Updates |

= =
nuevm BT [ s

Dashboard





image380.png
) [ [ ey





image381.png




image382.png




image34.png
Australia

B

siLeM
(51129




image383.png
Clear filter_ Drill Up

Values
Item name Drill- Down value Export To Masimize
— _Lr
Sols by Subcategor - ResclerSaes Amount v Rl TotalProdct Cost Bk he TS
s29.4m v || sosm v
Road Bikes Touring Bikes

3% 1059%

-1.17M -1.24M

ANAN AN





image384.png
.
orilUp

Clear Master Fifter

/' Reseller Sales Amount vs Reseller Total Product Cost

Reseller Order Countvs Internet Order Court
print Previe.

Export To PDF

Export To Image

Export To rcel

Touring Bikes





image385.png
Sales Amount by Category 1 Y i1 salesbyvears [SFH

Bikes
Road Biices Mountain Bikes’

Sales Amount

Touring Bikes

CV2007: 3475 %

Components

Mountain)





image386.png
Reseller by Country - Rese... (1] &

4.95K v
Australia

-91.81 %

-55.5K

Reseller Sales Amount

2m

1M

1M

2

2

th il

Reseller Sales Amount

Accessores

Bikes

Componerts
Clothing

7t
[ponents:





image387.png




image388.png
“"\‘/ % B ali

u?hkta ‘Fwnk Gid  Chart Scatter
- Cart

Enable Multiple Master Filter for "

ot bindng o ”

Change arangemert sL3ongs for Reseler by Courtsy
Modify bindings for Reseller Sales Amount by Category’

Undo 2 Actons





image389.png
Dashboard




image390.png
Dashboard




image391.png
{8 Business Analysis Tool (Report Module) - hitp://127.0.0.1:8583/

Application  Module  Reports  Report Dashboard  View  Tool

B @t 6 © g ¢

T & 8B

Dashboard (Version 1) | Map (Version 1)

scatter
A
33
€
5
3
8
5
2
O 2k
)
g
g
“ o)
Emy A 12
Dashbord_Category o 2
ey Rese
[——
;
o saes Groun)
G Add v
P—
© Copy
f— & Delce
Delete Al But This
alfrred Delete All
Do Ot S| Shre [\
Trend € Refresh Dats
Fuwevens | <O Automatic Data Refresh
Exportto POF...
Exportto mage...
2 Pt





image35.png
EdtFiter Clear | Ignore Master
Fiters

Fitering Interactity





image36.png
A BEreexod

)

Export To PDF

Export To Image.
Export To Excel

Export Dashboard »

AEEHHEBEEERIEE




image37.png




image38.png




image39.png
~ United Kingdom

~ United States

Grand Total

Clothing

Clothing

Clothing

Clothing

Clothing

Bikes
Clothing

Grand Total

Resellr Sales A... | Reseler GrossP...

ez

Sa2oK.
siLeM

s3.56M

Br
sLsM
716K
s34

st
s
sLom
$68.1M

($1320
s
(51129

($1360
s15.5
($1360
(s82)
7.2
BEr's
(5396K)
15K
(57586




image40.png
Column Add FormatRule >

B it Rules

Rove B Clesr Rules
i 55 Rename...
1 Category.




image41.png
Format type: Crrency.

Unit: Auto

Predision:

Currency: Use dashboard settngs.
Culure: Use dashboard setings
] ndude group separator

$1.238
($1.23B)





image42.png
Auto
General

Scientifc
Percent





image43.png
HE





image44.png
Values

| Reseler ses amount. @ |""‘"‘

Grand Total

Resellr Gross Profit Format. Resellr Sales A... | Reseler GrossP..
- V' Show Values hes s1am (1320
V' Show Totals thing s2.0 5738
Columns. / ShowGrend Totels =5 Lo =9
Column | AddFormatRule  » | Value » e
N o (s1360
B Edit Rules. Top/Bottom > s1s.5
Rows. B Clear Rules Average »om $1350
t Country Rename... [ Epresion x 2
t Category & lconRanges " e
< sk s34
Row - UntedStates | 5| 8 Color Ranges > B (53960
C = GradintRenges 4 s15
R Grand Total 2 o ™ (5758
B BarColorRanges  »
B Bor Gradient Ranges »
R | B BarGradientRanges » |





image45.png
FluutTuuis




image46.png
Grand Tota
Reseler S .. | Reseler Gross ..
< st = r ) 20
51 Show Caption o =
- Conacit () Duplicate sien (1120
% Delete $375K $53.K
] o ConvenTo N (13850
$128K $15.5K
~ Gamar @ Remove Datstems = e
[% Transpose 716K (s382)
- United{ B Edit Rules sam (.20
I | stk $13.4K
it Names
< | N oM (53950
Y EditFiter sLom 15K
GandTod G Clear s (57590
@ Update
@ Reset Layout Options
Maimize
Print Preview..
Export To POF
Export To Image
Export To Bxcel
Export Dashboard ,





image47.png
EditNames

Dashboard item name.
Sales Amount Gross Profitby Country
Values

Reseller Sales Amount

Reseler Gross Profit





image48.png
‘Sales Amount/ Gross Profit by Country

~ United Kingdom

~ United States

Grand Total

Clothing

Clothing

Clothing

Clothing
Bikes
Clothing
Bikes
Clothing

Grand Total

Resellr Sales A... | Reseler GrossP...

L3

sa2.3K
siLeM

s3.56M

s
sus
716K
s34

stis
saaam
sLow
a1

(51320
s
(51120
s
(s1360)
15,5
(s1360)
(s82)
@m0
BErs
(398K
stsi
(67580




image49.png
L] PVBLS 00}

Home  Data | Desin

=R

Show Caption_ EditNames | Irital
State
Common’ Initial S.





image50.png
L] POt





image51.png
8 Dashboard Designer

(2 Y





image52.png
18 Business Analysis Tool (Report Module) - http:/flocalhost:8204/

‘B @ G TR (C & BE

Application  Mode  Reports Report Dashboard View Toos Help

" Dachboard2 Verson 3 x
-
S |0 s Reseller =}
R 2| | sales Amount/gross Profit by Country B
&= L
Resler o .| ReselerGrose .
~ R  Ausrala [Bkes sLam 1320
Reports | Dashboard_oid Clotiing s2K 7%
Dachboard sdes VCda [Bies sivam (1120
- dotng e ss2.
4 . < Fance Bhes e (1380
= Clothing $128K $15.5K
Eny - v Germany Bikes. $1.59 ($136K)
: Gotng sr1ac =)
 Urited Kngdon | Bkes sam <m0
||| 8 shared - Clotring s s34
e « Unteasttes | Bies swaam (53060
Clothing $1.0M $151K
Grand Total $68.1M (§758K)

Login:john | Server: htps/focahost:8204/





image53.png
18 Business Analysis Tool (Report Modue) - htip:/,

Applicatin_Mode  Reports Report |
GEe Cc&

Dashboard2 (Version 1)





image54.png
‘Sales Amount/Gross Profit by Country

GrandTotal
Reseler Sales .. | Reseler GrossP...
~ Australia o - ($1320
el B show Coption s
~ Canada Bike (J Duplicate (s11:)
ot & Delete $53.
- France Bke 25 Convert To » $1350
% & Remove ata tems sis
- Gemeny b (51350
ot [ Transpose =
~ UnitedKingdom ke B Edit Rules oz
ot A Edit Names. ELY
- UnitedStates | Bke (53960
ol P EitFiter =
Grand Total W Clear (s758)
-]

Print Preview...

Export To PDF

Export To Image

Export To Excel

Export Dashboard ,





image55.png
Export To PDF - Sales Amount/Gross Profit by Country

Page Layout:

ShowTite:
Tite:

Print Headers on Every Page:
Scale Mode:

Scale Factor:

Auto FitPage Count:

© Forkraits
© Landscape:

Letter -

%4

Sales Amount/Gross Proft by Cour

%4

None -

[ Fiters.

Belon





image56.png
Export To Excel - Sales Amount/Gross Profit by Cou... | X |

ExcelFormat: (5K

Separstor: |
Incude: [Fiters.

[l parameters
Positon: Belon





image57.png
Export To Image - Sales Amount/Gross Profit by Co...

Image Format:  BNG I
Show Tite: ]
Tite: Sales Amount/Gross Profit by Cour
Resolution (¢pi): %2
Inciude: [ClFiters.

[l parameters





image58.png
= 50 alll

Pivot  Grid  Chart Scatter

e




image59.png




image60.png




image61.png
No optons avaiable for tis column type.

Apply





image62.png
O Hyperink

© value

Bar

Value type:

Resultindication:

Threshold type:
Threshold value:

Absolute variation
Greater s good

Percent -

Cancel

o

J[ ey |





image63.png
Category.

Reseler Sales Amount

Internet Order Quanity

Reseler Order Quanity

New Column

Grid1

thil

Category | Reseller Sales Amount | Internet Order Quantity vs Reseller Order Quantity

ST
se6.M

Delta Values

0.3
EX3 4
K

Delta Indication





image64.png
Column Options.

Column type:
Dinension
O Measure:
© pelta
O sparkine
O Hyperink

© value
Oar

Value type:
Resultindication:
Threshold type:
Threshold value:

Absolute variation

‘Actual value
Absolute variation
Percent variation

Percent of target.

Apply





image65.png
Column Options.

Column type:
Dinension
O Measure:
© pelta
O sparkine
O Hyperink

© value
Oar

Value type:
Resultindication:
Threshold type:
Threshold value:

Absolute variation
Greater s good

Greater s good
Less s good
Warring i grester
Warming iless

No ndication

Apply





image66.png
Column Options.

Column type:
Dinension
O Measure:
© pelta
O sparkine
O Hyperink

Show:.
© value
Oar
Value type:
Resultindication:
Threshold type:
Threshold value:

Absolute variation
Greater s good

Percent

Absoute
Percent

Apply





image67.png
Column Options.

Cotamn type: show:
Dimenson © vake
O vezsre Osar
©pelts Value type: Percentvaraton <
© sparkine. Resutindeaton: | Geatersgood v
O Hyperink Theshodtype:  percent v
Theshodvave: | 000% 3|

“

O





image68.png
e L
Categry | Reseer S Amount | nsmetOrder Quanty vs Reslr rce Quantty

Accessories 7 +3265% A
Bikes. o8, TT%W
Clothing su7M 85.89% W

Components s11aM




image69.png
Reseler Sales Amount =

Internet Order Quanity

Reseler Order Quanity

New Com &

Column Options
Column type: Show:
Oimension Ovae
O Measure @b
©eta ] Avys show zeolevel

A
\Om:

O Hyperink





image70.png
Resellr Sales Amount

ST
a5,
sL7M
s11am

[Lif
Intemet Order Quantity vs Reseller Order Quantty




image71.png
HIDDEN DATA TTEMS

Column Options.

Column type:

Dimension

[ show start/end values.
Sparkine view type: Lne
] Highight min/max points
] Highight start/end points.

Aeply





image72.png
Column Options.

Column type:

Dinension
O Measure:

O et

© sparkine
O Hyperinkc

¥ show tartend vakes

¥ Highicht minjmax points
¥ Highicht startfend points





image1.png
18 Business Analysis Tool (Report Moduie) - ttp://127.0.0. 1:8510/

<K< < > > > & @

Logn:john | Server: htps//127.0.0.1:8510/





image73.png
thil

e TS T e
7K N i
s 75 o e 55
e | 27 e w1
b s





image74.png
Start/end values

7 e ttrns

[

Min/max points

Start/end points




image75.png
el - £
A B c
Name. Link Reseller Sales
1 |Amount
2 |Australia httos://en. wikivedia.ore, wstralia 1,594,335.38 |
fill| Canzvia) httos:/en.wikipedia.ore/ anada 14,377,925.60)
4 [France hitos:/en.wikivedia.ore/wiki/Eran ,607,537.94|
5 [Germany. hitos:/en.wikiedia.ore/ rman 1,963,988.04)
6 [United Kingdom | 1pe//en wikinedia-ore/wiki/United Kin| 4275,008.63
7 [United States | hiipes//en wikinedia-ore/wiki/United Stal 53,607,801.21
8





image76.png
Argument

HIDDEN DATA ITEMS

Dimensions.

Dimension

Column Options.

Column type:
O Dimension

O Measure

Obea

O sparkine

© Fiyperinid
p

URIPattern:

Insert Placeholder

Cancel

[enly |





image77.png
Lk

n
n
n
n
ht

+/fen wkiped.or

/fen whipedi.or
/fen whipedi.or
/fen whipedi.or
/fen whipedi.or
fen. wikipedia, or

ifAustral
ifCanada
ifFrance
ifGermany
jifLrited Kingdom
jii/United States

Resellr Sales Amount (Sum)

i o

159
1M
a6m




image78.png




image79.png
URIPattern:

Insert Placeholder

Aeply





image80.png
Reseler Sales Amount (.. OffcalName.
159 Commonuealth of Australia
14,4 Canads.
4,61 French Republic
1.96M Federal Republc of Germany

4.28M  United Kingdom of Grest Britain and No.
53.6M United States of America





image81.png




image2.png
8 Business Analysis Tool (Report Moduie) - http: flocalhost:8204/

Application  Modude  Reports  Report  Dashboard

B @ GEe C &R

View Toos Hep

Dashboard? (Version 1)

Australia

a5
55,5

v 8.19 %

23.76 %
— A o

186K

v 69.14 %
s

Germany
738
Sx

v 1222%
e

st ﬁs,m,...\msm.. | Reseler order Quanty va . |

Bib-Shorts 0

st67
sisa 565.24% A

EX 2u%W
sk

B
s 279.50% A
.35
sx 255% A v

I Soecilty Sikeshop [l Value Addes Reseler
I warehouse

33m

30m

Reseller Sales Amount

Bikes Components
Accessores Clothing

Logn: john | Server: htp:/focahost:8204/





image82.png
URI Pattern: | https: //en. wikipedia.org/wiki/{0}
[ Tnertlcehldr |

Apply





image83.png
Grid1
Name Resellr Sales Amount (Sum)
Uited States.

Urited ingdom

Germany

France.

Canada

Australia





image84.png
L] Grid Tools

=
* % (IR B

T B o o || (e mpe
et el | ol [ e
g | — nterscvy setigs





image85.png
Columns

Category

Reseler Sales Amount x

Internet Order Quantity
Reseler Order Quantity

Reseler Order Count -~

New Cotamn &

A





image86.png
Resellr Sales A... | Internet Order Quantity vs .

sioa|

. [l

x|
Heinets s | [y
HydratonPacks sess | e A a0
Lods ste.x He e
Punps. st 2o A

Tres and Tubes < I 2. ———




image87.png
sucategry Resler e ..t Oder Quantty s .| Resler OderCrt
G T T R




image88.png
L] AN OotES Dashboard Designer
Home  Data | Deson

(O | [E]l[=] s & @& &S

Show Caption | EditNames | Horizontal | Vertical | Banded | Merge | Column | WordWrap | AutoFitto AutoFit | Manual
Lnes | Lnes | Rows | Cels | Headers Contents o Grd

Common Style Layout Column Width Mode




image89.png
Category | Reseller Sales Amount | Internet Order Quantity vs Reseller Or
Hecerioies 573 e
e o I

catg e

Components $11.8M





image90.png
Subcategory. Reseller Sales Amount | Internet Order Quantity vs Re...

Bike Radks st

ke Stancs

Sottes and Cages s Wl

Cleaners. sux|

Fenders

Helmets sas |

Hydration Packs. ses.s |

Lods st6.

Pumps st

Tres and Tubes = I

Touring Bikes s10.5m |




